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Utilizing hydrology and geomorphology relationships to estimate 

streamflow conditions on Maui and O‘ahu, Hawai‘i 

 

ABSTRACT:  As the population on the island of Maui drastically increases, water resource 

demands continue to rise.  In order to match water demands and to manage water resources, it is 

important to understand streamflow and drainage basin interactions.  If relationships between a 

drainage basin’s hydrologic and geomorphologic characteristics can be quantified, then 

streamflow conditions of ungaged streams can potentially be estimated.  The baseflow recession 

constant is an important variable to analyze for water management, yet until this study, recession 

constants were not calculated for the island of Maui, or Hawai‘i as a whole.  Recession constants 

of currently gaged streams on Maui correlated to the permeability and flow conditions of the 

watersheds.  Streams with recession constants >0.95 were generally placed in areas of the island 

with dike-impounded groundwater and streams with recession constants <0.95 were generally 

placed in areas with dike-free groundwater.  Recession constants <0.90 also indicated near 

perennial and/or intermittent streams.  Hydrologic variables such as baseflow recession constants, 

low-flow values, and change in storage values are generally correlated to a watershed’s 

geomorphologic variables such as drainage density, hypsometric integral and concavity index.  

Based on equations produced from the relationships between a watershed’s hydrology and 

geomorphology, drainage density and hypsometric integrals are potential indicators of hydrologic 

variables and streamflow conditions.  The same analysis can be done on other islands in Hawai‘i, 

but the specific relationships between hydrology and geomorphology must be determined for 

each island.  The understanding of baseflow recession constants and relationships between a 

watershed’s hydrology and geomorphology can contribute to water resource management.  

Having the potential to predict flow conditions of ungaged streams provides a tool to identify 

which streams are most ideal as a freshwater source without expending extra resources to 

unproductively gage streams and drill for water.   
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1. Introduction 

Despite efforts to conserve water in Hawai‘i, demands are increasing as the population of the 

islands continue to grow.  With a population of 1.36 million people, Hawai‘i withdrew 671 

million gallons of freshwater per day in 2010 (Maupin et al., 2014).  Specifically, Maui’s 

population increased 43.7% within the last 20 years (U.S. Census Bureau, 2010 Census) and the 

County of Maui Department of Water Supply (MDWS) produced an average of 37.5 million 

gallons per day (Johnson et al., 2014).  That average value of produced water is expected to 

increase 12 to 57 percent by 2030 (Johnson et al., 2014).  In order to meet these increasing 

demands, fresh groundwater systems need to be studied to determine the availability of the 

resources (Johnson et al., 2014).  Flow conditions provide insight into the type of stream and 

relative amount of water within each drainage basin.  Relationships between hydrologic and 

geomorphologic parameters of drainage basins have the potential to predict a stream’s flow 

condition, informing us of which streams are the most useful to supply the community with 

freshwater resources.    

The Hawaiian Islands are a group of shield volcanoes produced by multiple lava flows.  The 

interior lava flows are mainly basalt, but then grade out to younger andesite flows, therefore 

making the interior of the flows more porous and permeable than the exterior of the flows (Cox, 

1954).  Throughout the islands are fissures in rift zones, which were filled with lava to form dikes 

(Cox, 1954).  The islands’ lava flows have a high average permeability, resulting in a high 

infiltration to rainfall ratio (Cox, 1954). The precipitation works its way down and accumulates as 

three main groundwater reservoirs: perched groundwater, dike-impounded groundwater, and 

groundwater floating on salt water (Cox, 1954).  The first two reservoirs are the main sources of 

water supply. 

Maui was selected as a case study and O‘ahu was selected as the test case for this thesis because 

of their growing demand for water.  O‘ahu is heavily populated and Maui’s population is greatly 

increasing, therefore making the two islands important locations to study water resources.  Since 

Maui and O‘ahu have similar shield-forming stages, but differ in age and erodability, the two 

islands can be compared to determine how geomorphologic factors affect the hydrology of the 

islands.  
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1.1 Maui’s Hydrogeology 

Maui is the second largest island in the Hawaiian island chain, with an area of 728 square miles 

(Stearns and Macdonald, 1942).  Maui is formed from two shield volcanoes, Mauna Kahalawai to 

the west and Haleakalā to the east, which are connected by an isthmus forming a valley in the 

middle (Figure 1a) - hence the island’s nickname: “The Valley Isle” (Stearns and Macdonald, 

1942).  With its diverse environments and ecosystems, Maui is unique to the Hawaiian island 

chain.  The island experiences different micro-climates between districts, with the city of Hana on 

the east side of the island being wet and warm, the city of Lahaina on the west side hot and dry, 

and the summit of Haleakalā cold and semi-arid.  Maui’s volcanic layers are intruded by dikes 

(Figure 1b), which were created as magma rose through narrow, vertical cracks within the 

volcanoes and solidified (Stearns and Macdonald, 1942).  The dikes’ lower permeability, relative 

to the lava flows, impedes groundwater flow, causing groundwater to flow parallel to the dike’s 

orientation (El-Kadi and Moncur, 2006).  Closer to the dike-free coasts of the island are lens-

shaped water bodies, known as freshwater-lens groundwater systems (Figure 1b), which are 

perched within volcanic basalt that is of higher-permeability than the dikes themselves (Johnson 

et al., 2014).  Since freshwater is less dense than saline groundwater, the freshwater sits atop the 

saltwater and lower-permeability geologic layers, and typically flows toward the ocean (Johnson 

et al., 2014).   
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Figure 1. Case study location and hydrogeology schematic. (a) Map of Maui displayed with 

drainage basins used in this thesis and dike-impounded areas.  Dike outlines provided by Maoya 

Bassiouni, USGS, pers.comm. July 2014. Inset map displays State of Hawai‘i with Maui shaded 

in grey. (b) Illustration of dike intrusions causing compartmentalization of groundwater. 

Illustration was recreated for Maui based on figure from Gingerich and Oki, 2000. Illustration not 

drawn to scale. 

 

Haleakalā’s summit, Pu‘u ‘Ula‘ula, stands at 10,023 feet above sea level, exhibiting a classic 

shield shape with broad slopes (Johnson et al., 2014).  The western slopes of Haleakalā are drier 

and broader compared to the wetter eastern slopes.  Mauna Kahalawai, also known as the West 

Maui Mountains, contains deeply carved valleys due to erosion.  Its summit, Pu‘u Kukui, stands 

at 5,788 feet above sea level (Johnson et al., 2014).  The most rainfall occurs on the slopes of the 
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island at 2,000 to 6,000 feet above sea level, but can vary from island to island depending on the 

location and topography (Oki, 2004).  Because of the relatively steep topography of the Hawaiian 

Islands, the northeastern sides of the islands receive more rainfall (Figure 2) due to the tradewinds 

from the north Pacific anticyclone (Johnson et al., 2014; Oki et al., 2010).  The islands experience 

a wet season from October to April, where tradewinds blow 50-80 percent of the time, and a dry 

season from May to September, where tradewinds blow 80-95 percent of the time (Gingerich, 

2008; Oki et al., 2010).  The island of Maui receives an average rainfall of 81 inches per year; 

Pu‘u Kukui in particular receives an average rainfall of 360 inches per year, and the northeastern 

mid-slopes of Haleakalā receive an average rainfall of 200 inches per year (Johnson et al., 2014).  

In comparison, the southwestern slopes of Haleakalā receive 25 inches of rain per year, as this 

area falls within the rain shadow (Johnson et al., 2014).   

 

 

 

Figure 2. Map of Maui displaying average annual rainfall in inches (Giambelluca et al., 2013). 

All of the drainage basins used in this study are outlined in black.  
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Maui’s location, topography, and climate system affect the island’s complex hydrogeologic 

system.  It has been found that one of Maui’s streams, Waihe‘e, has a baseflow greater than its 

recharge (Johnson et al., 2014).  This result provides evidence for groundwater sharing between 

watersheds, which was previously seen on O‘ahu in the 1940s, when the Haiku tunnel was 

created (Hirashima, 1963).  This tunnel went through four dikes and consequently drained water 

at a rate of 11 million gallons per day for several months throughout the construction process 

(Hirashima, 1963).  Continuous withdrawal caused water that typically drained into Kahalu‘u 

Stream to feed into Haiku Valley (Hirashima, 1963).  This relationship is evidenced by a decrease 

in discharge from Kahalu‘u Stream by 26% (Hirashima, 1963).  Despite the fact that the 

groundwater sharing on O‘ahu was caused by anthropogenic affects, it is believed that 

groundwater sharing is naturally occurring at Waihe‘e Stream on Maui (Delwyn Oki, USGS, 

pers. Comm. July 2014). 

1.2 O‘ahu’s Setting and Hydrogeology 

O‘ahu, with an area of 596 square miles, is the third largest island in the Hawaiian island chain 

(Engott et al., 2015).  O‘ahu was formed by two shield volcanoes which have eroded away to 

form steep mountains with deeply cut valleys (Engott et al., 2015).  The older western side of the 

island is made of lava from Wai‘anae Volcano and the younger eastern side of the island is made 

of lava from Ko‘olau Volcano (Figure 3).  O‘ahu is made of two shield-stage lava flows which 

are intruded by dikes that are less-permeable than the basaltic lava flows.  There are specifically 

at least 1,000 dikes per mile within the central area of the two rift zones that cut through the 

elongated volcanoes (Figure 3) (Engott et al., 2015).  Similarly to Maui, O‘ahu also has areas of 

freshwater lens-shaped bodies, which are surrounded by lava flows of greater permeability.  As in 

the case of Haleakalā, the eastern Ko‘olau mountains receive more precipitation than the 

Wai‘anae mountains, which fall into the rain shadow (Figure 4) (Engott et al., 2015). 
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Figure 3. Map of O‘ahu displaying drainage basins and dike-impounded areas.  Dike outlines 

provided by Maoya Bassiouni, USGS, pers.comm. July 2014.  Inset map displays State of Hawai‘i 

with O‘ahu shaded in grey. 

 

 
Figure 4. Map of O‘ahu displaying average annual rainfall (inches) with isohyets (Giambelluca et al., 

2013). Three of the currently gaged drainage basins are outlined with black. 
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1.3 Recession Constants, k 

Low-flow recession constants inform us of the natural storages that capture and feed groundwater 

into streams, which reveal the hydrogeologic settings of the area (Tallaksen, 1995).  Groundwater 

discharge analysis compares drainage basin characteristics with the geology of the area (Knisel, 

1963).  Recession constants are dimensionless values that delineate the rate at which a stream’s 

flow decreases as the stream is being recharged with groundwater (Vogel and Kroll, 1996).  

Recession constants are calculated based on exponential functions between time and stream 

discharge (Figure 5).   

 

Figure 5. Graph displaying how the steepness of a hydrograph’s falling limb correlates to the 

relative recession constant value.  Lower recession constants correlate to steeper falling limbs.  

Hydrographs with steeper falling limbs are typically set in areas of higher permeability, lower 

porosity, and small distances to the groundwater divide.  Higher recession constants correlate to 

flatter falling limbs.  Hydrographs with flatter falling limbs are typically set in areas of lower 

permeability (i.e. dike-impounded areas), higher porosity, and larger distances to the groundwater 

divide. Graph created by D.S. Oki.  
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The recession constant, k, is derived from the discharge equation  

     𝑄 = 𝑄𝑜𝑒−𝛼𝑡                                                     (1) 

where the recession the recession constant, k, is determined by the equation  

𝑘 =  𝑒−𝛼                      (2) 

as noted in Thomas et al. (2013).  An exponential function quantifies the relationship where the 

dependent variable proportionally changes the same change as the independent variable.  

Recession constants are calculated from the baseflow recession curve, which indicates when the 

streamflow is returning to flow derived from groundwater (Fetter, 2001).  This can help 

determine the hydrogeologic settings of the streams and indicate the stream’s low-flow discharge 

variability, which can be used for various purposes such as irrigation, water supply, and quantity 

estimates (Tallaksen, 1995).  High recession constants indicate steadier hydrographs with flat 

falling limbs, suggesting a slower depletion of base runoff (Carlston, 1963).  Lower recession 

constants indicate flashier hydrographs with steeper falling limbs, suggesting a more rapid 

depletion of base runoff (Carlston, 1963).  Recession constants are useful in estimating aquifer 

properties and potential recharge.  The baseflow recession curve follows the rising limb of the 

hydrograph, which is an increase in discharge, usually caused by rainfall, and the falling limb, 

which indicates that the discharge and stream level are decreasing (Figure 6) (Fetter, 2001).  

Recession constants could potentially identify perennial and intermittent streams, which would 

indicate the usefulness of a stream for water resources.  Despite the importance of these low-flow 

recession constants, there are currently no published recession constants for streams in Hawai‘i.   

 
Figure 6. Example of a desired “clean” hydrograph following a storm event with little to no 

peaks interrupting the recession. AB is the rising limb, BC is the falling limb, CD is the base flow 

recession. Points C and D are visually determined while picking out the recession curve. 
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1.4 Geomorphology 

The shape and form of a watershed is closely linked to its hydrologic response (Rodriguez-Iturbe 

and Valdes, 1979). The movement of groundwater and surface water helps to shape a watershed, 

which can control how the water moves.  The geomorphology of a watershed impacts the rate of 

discharge from a drainage basin (Langbein et al., 1947), therefore influencing the baseflow 

recession constants of that basin.  Geomorphologic parameters, such as drainage density, 

hypsometric integral, and concavity index are critical features that influence a watershed’s stream 

discharge.  Drainage density is the total length of the streams within a drainage basin divided by 

the area of that basin (Bierman and Montgomery, 2014).  The drainage density value indicates 

how well a watershed drains.  Higher drainage densities indicate that a basin drains quickly 

because there are more conduits/streams draining water within a unit area, by decreasing the lag 

time to peak discharge (Harlin, 1984).  The higher drainage density is reflected by pronounced 

discharge peaks and steeper falling limbs.  According to the National Institute of Hydrology 

(http://www.nih.ernet.in/learning_hyd.html), lower drainage densities indicate that a basin is not 

well drained, therefore reflected by hydrographs with shallow rising and falling limbs.   

Hypsometric integral values reflect the erosional maturity of the drainage basin (Sarp et al., 2011) 

as well as how prone the basin is to more erosion (Singh, 2008).  The hypsometric integrals 

indicate the relative basin relief and amount of land mass found at different elevations of the 

watershed.  Higher hypsometric integrals indicate relative higher relief and lower hypsometric 

integrals indicate relative lower relief (Bierman and Montgomery, 2014).  Therefore, higher 

hypsometric integrals correlate with less-eroded basins and lower hypsometric integrals with 

lower relief correlate with heavily eroded basins.   

Concavity indices reflect the surface processes believed to have formed the watershed and its 

stream (Bierman and Montgomery, 2014).  Concavity indices <0.3 reflect streams with steeper 

headwaters, concavity indices between 0.3-0.7 reflect fluvial incision, and concavity indices >0.7 

reflect alluvial rivers (Bierman and Montgomery, 2014).  Most streams have a negative concavity 

index, reflecting a concave stream profile, while a positive concavity index reflects a convex 

stream profile.  These three geomorphologic variables are linked to the hydrology of a watershed 

and can shed light on streamflow conditions. 

 

 

http://www.nih.ernet.in/learning_hyd.html
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1.5 Previous Works 

By analyzing the relationship between geomorphologic parameters and baseflow recession 

constants, previous studies have aimed to predict low-flow estimates of streams in the northeast 

United States.  These studies found that groundwater flow is controlled by the physical properties 

within a drainage basin and resultantly can be seen in the basin’s geomorphic qualities.  The 

study sites – the Allegheny Mountains, Massachusetts, and New Jersey – are located in areas that 

generally experience humid continental conditions with warm (temperatures above 50°F) humid 

summers and very cold winters (average 26.6°F during coldest month).  The summer conditions 

of these places are somewhat comparable to Hawai‘i, but Hawai‘i experiences warmer conditions 

on a more regular basis throughout the year.  According to the National Oceanic and Atmospheric 

Administration (http://www.weather.gov/climate/index.php?wfo=hnl), Hawai‘i has an average 

temperature range of 80-90°F and experiences an average annual humidity of 70% at sea level. 

The different conditions that Hawai‘i experiences could impact the relationships between 

recession constants and geomorphologic parameters of watersheds. 

Zecharias and Brutsaert (1988) examined the relationship between baseflow recession constants 

and the geomorphic and soil characteristics of watersheds from the Allegheny Mountain section 

of the Appalachian Plateau.  In this study, they determined that the reaction factor, a baseflow 

recession time scale, is correlated to the land slope, drainage density, hydraulic conductivity, and 

rock porosity of the watershed.  Drainage systems in this area are not strongly impacted by 

structural controls and slopes demonstrate V-shaped valleys.  The climate is humid continental 

and 75% of the area is covered with forests. Zecharias and Brusaert found that generally, the 

steamflow of humid forested areas, are comprised of baseflow.  This emphasizes the importance 

of understanding the relationship between the rate at which groundwater flows within a drainage 

basin and the geomorphic parameters that control that flow, since the discharge of groundwater is 

dependent on the basin’s lithology, which can also be reflected as the basin’s morphology.  

Vogel and Kroll (1992, 1996) calculated regional regression models from 23 sites in 

Massachusetts, where it typically experiences humid continental conditions.  They found the 

importance of understanding low-flow statistics in order to manage water quality and water 

supply.  They determined a relationship between low-flow statistics and three different variables 

– drainage area, basin slope, and baseflow recession constant.  They found that baseflow 

recession constants, drainage area, and basin slope explain over 90% of the low-flow discharge 

http://www.weather.gov/climate/index.php?wfo=hnl
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statistic variability.  Therefore, the recession constants could act as indicators of basin hydraulic 

conductivity and soil porosity, as well as a relationship between low-flow statistics and variables.  

Thomas et al. (2013) created regression models to analyze how anthropogenic water withdrawals 

in New Jersey (which has a high density population) affect the baseflow recession constants.  

They found that the baseflow recession constants are useful in analyzing rainfall-runoff models, 

separating baseflow, and estimating low-flow statistics of ungaged streams.  Results suggested 

that geologic characteristics such as drainage density and basin slope are important factors in 

determining recession constants and that groundwater withdrawal increased recession constant 

estimates. They found that the geomorphology most impacted the recession constant, suggesting 

that drainage density was the main cause of variability amongst recession constants.  

These studies were all conducted in areas with similar climate conditions in the northeast and 

mid-Atlantic United States and found relationships between stream discharge, baseflow, low-flow 

statistics and geomorphological parameters of the drainage basins.  They found the importance of 

analyzing recession constants and geomorphology to determine low-flow statistics for potential 

water supply.  Knisel (1963) noted that hydrologists recognize that geology plays an important 

role in water yield, so it is not sufficient to only analyze the discharge data, but to also analyze its 

relationship with geologic and geomorphologic data.  Despite the importance of this relationship, 

nobody has analyzed these hydrologic and geologic relationships in Hawai‘i.  A recent report by 

the USGS Pacific Islands Water Science Center (Johnson et al., 2014) analyzes Hawai‘i’s annual 

recharge of streams under various climate conditions and the physical conditions that could affect 

the recharge.  By considering multiple variables for the entire island of Maui such as, rainfall, fog 

interception, direct runoff, irrigation, septic-system leachate, excess water, and moisture storage, 

this report is currently the most robust stream analysis.  However, it does not include recession 

constants or whole-basin geomorphologic parameters such as drainage density, hypsometry, and 

concavity, which have proven to be important in the other studies.   

1.6 Current Work 

The objective of this thesis is to apply this previous research to the unique conditions of Hawai‘i 

while also introducing low-flow recession constants and whole-scale basin parameters.  The 

findings from this thesis are used to provide insight into how hydrologic and geomorphologic 

variables relate to each other within a watershed, and specifically how baseflow recession 

constants can be crucial indicators of a stream and drainage basin’s hydrology.  I understand that 
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the recession constant is a complex parameter that is affected by various factors such as, time, 

precipitation, peak discharge, lithology, and geomorphology.  However, for this study, I chose to 

primarily focus on how the geomorphology of a watershed relates to the recession constant.   

I aim to address the overarching question of whether it is possible to predict streamflow 

conditions based on hydrologic and geomorphologic variables.  The goal is to determine if we can 

predict the flow conditions of an ungaged stream based on the watershed location and 

geomorphology.  Deriving from the main question, this thesis also aims to determine whether 

geomorphologic variables can recognize groundwater sharing between Waihe‘e and ‘Īao streams 

on Maui, and if so, which variables best accomplish this.    
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2.  Methods 

In order to identify relationships between geomorphology and hydrology, I used two basic types 

of data, hydrologic data and geomorphologic data, and compared the two data features to each 

other.   

2.1 Hydrologic Parameters 

The hydrologic data collected for this thesis included baseflow recession constants, low-flow 

values, recharge, baseflow, and change in storage values (Table 1).  

2.1.a Baseflow Recession Constant, k 

During an internship at the USGS Pacific Islands Water Science Center in the summer of 

2014, I calculated baseflow recession constants for the nine currently gaged streams on Maui.  

Baseflow recession constants (k) can inform us what physical factors, such as dikes, influence 

the way groundwater reacts to recharge.  I retrieved all of the available discharge data of the 

nine current continuously-gaged streams of Maui – Honokōhau, Kahakuloa, Waihe‘e, ‘Īao, 

Honopou, Waikamoi, West Wailuaiki, Hanawi, and ‘Ohe‘o – from the USGS Pacific Islands 

Water Science Center (http://maps.waterdata.usgs.gov/mapper/index.html).  The discharge 

values for each stream were plotted as a hydrograph against time (Figure 7).   

 

Figure 7. Example of a hydrograph over one water year (October 1 – September 30).  Each peak 

indicates the stream’s water discharge after a storm or rain event. Individual peaks and falling 

limbs were picked out from hydrographs in order to calculate the baseflow recession constants for 

each stream. 
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I selected recession curves that are relatively clean (i.e. are not interrupted by large peaks) 

and follow a discharge peak that is at least five times the median discharge (Appendix A) of 

the stream.  I then visually determined when the recession curve ends by establishing when 

the curve flattened out, typically when the discharge values stopped receding before a new 

discharge peak occurred.  The recession constant, k, was quantified using a best-fit 

exponential curve equation (Figure 8) (Thomas et al., 2013) 

      𝑄 = 𝑄𝑜𝑒−𝛼𝑡                                                     (1) 

where the recession constant, k, is determined by the equation 

𝑘 =  𝑒−𝛼                      (2) 

 
Figure 8. Example of a recession curve with best-fit exponential line (green). Recession  

constant (k) is equal to e-α. 

 

It is important to point out that other studies define their recession constant differently and 

that difference affects the way the data should be analyzed against other geomorphologic 

variables.  Authors such as Brandes et al. (2005) define their recession constant as just α (not 

–α) from Equation 1.  This difference in definition means that k and α are inversely related to 

each other, as according to Equation 2.  

An objective automated method to determine the end of the recession period was tested, but 

this method produced inconsistent results.  With this method, I calculated when 90% of the 

discharge values are the same within a 24-hour period, therefore indicating that the recession 

is stable and complete.  With this method, the COUNTIF function in Excel was used to count 

the number of flow values within a 24-hour period (12 hours prior to and 12 hours after) that 

matched the flow value of the current time.  Since the discharge values were collected in 
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intervals of 30 minutes, there are a total of 49 flow values within the 24-hour period (24 

values during the 12 hours prior, 24 values during the 12 hours after, and 1 value for the 

current time).  Therefore, if we want 90% of the flow values to match the current flow value, 

45 of the 49 flow values need to be matched (Figure 9).  However, it was noticed that the 

recession continued past the estimated end of the recession, so the recession curve was 

oftentimes cut short, which affects the time duration and recession constants.  

 

Figure 9. Example hydrograph with objective automated method to determine the end of a 

recession period. The solid line is the flow and the dotted line corresponds to the number of 

values that are the same as the flow value indicated at that time. The red lines indicate where 

the 90% criterion was met.  When the dotted line reaches a value of 45, 90% of the flow 

values within a 24-hour period matches the current flow value, therefore indicating the end of 

the recession period. 

 

I found that the recession constants correlated to the general lithology of the island, where 

higher recession constants were calculated from perennial streams in areas in which 

groundwater is dike-impounded and lower recession constants were calculated from streams 

in areas with dike-free groundwater or intermittent streams.  After noticing the correlation 

between general lithology and recession constants, I was motivated to analyze whether a 

stream’s flow condition could be predicted from various watershed parameters.   

2.1.b Low-flow Values, Q95 

The Q95 exceedance percentile tells us that a stream’s discharge value is expected to exceed 

the Q95 discharge value 95% of the time (Pyrce, 2004).  Q95 values (along with Q90 values) 

are widely considered as low flow indices (Pyrce, 2004).  Low-flow values were computed 

by creating flow-duration curves for each stream (Figure 10 and Appendix A).   
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Figure 10. Example flow-duration curve. All flow-duration curves for currently gaged 

streams on Maui can be found in Appendix A.  

 

 

2.1.c Recharge 

Recharge values were calculated with a GIS data set provided by the USGS Pacific Islands 

Water Science Center (http://water.usgs.gov/GIS/metadata/usgswrd/XML/sir2014-

5168_Maui_water-budget_components.xml) which was used in the Johnson et al. (2014) 

study (Figure 11).  The data set contains a file that divides Maui according to the type of 

landcover and calculates various hydrologic variables for each landcover polygon.  

Hydrologic variables include rainfall, runoff, total evapotranspiration, fog, and recharge (all 

of which are measured in inches per year).  Recharge values were clipped for each watershed 

analyzed in this thesis and converted to units of cubic feet per second (Appendix B).  The 

same process was done for the island of O‘ahu with a data set used in the Engott et al. (2015) 

study (Figure 12). 
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Figure 11. Mean annual water-budget components used to calculate recharge for Maui.  The island is divided 

according to land cover, from which each watershed was clipped out for this thesis.  GIS dataset created by A.G. 

Johnson (2014) from the USGS Pacific Islands Water Science Center. 

 

 

Figure 12. Mean annual water-budget components used to calculate recharge for O‘ahu. The island is divided 

according to land cover, from which each watershed was clipped out for this thesis.  GIS dataset created by J.A. Engott 

(2015) from the USGS Pacific Islands Water Science Center. 
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2.1.d Baseflow 

Baseflow values were computed using program files provided by the USGS Pacific Islands 

Water Science Center which were developed by Wahl and Wahl (1995), and streamflow 

input files from NWIS and USGS (Appendix C). 

2.1.e Change in Storage, ∆S 

A basic water-budget equation of 

P = Q + ET + ∆S            (3) 

where P is precipitation, Q is runoff, ET is evapotranspiration, ∆S is change in storage 

(Fetter, 2001) was used to calculate the change in storage of each watershed.  By reorganizing 

Equation 3 in terms of ∆S, ∆S can be calculated by  

    ∆S = P – Q – ET            (4)  

Average annual precipitation and evapotranspiration values were computed from the mean 

annual water-budget components file from the Johnson et al. (2014) report provided by the 

USGS Pacific Islands Water Science Center (http://water.usgs.gov/GIS/metadata/usgswrd/ 

XML/sir2014-5168_Maui_water-budget_components.xml).  In this file, precipitation values 

were labeled as ‘Rainfall,’ evapotranspiration values were labeled as ‘Total ET,’ and the 

values are reported in inches per year.  The average precipitation and evapotranspiration 

values were multiplied by the area of the watershed (in square inches) to calculate a volume 

of precipitation and evapotranspiration in cubic inches per year.  Average annual discharge 

values were retrieved from the USGS Pacific Islands Water Science Center site (under 

Annual Statistics) for each stream. These values are reported in cubic feet per second, so were 

therefore converted to cubic inches per year to match the precipitation and evapotranspiration 

units.  Equation 4 was used to compute the change in storage based on the precipitation, 

evapotranspiration and discharge values for each stream.  

2.2 Geomorphology Data 

All of the geomorphologic variables were computed using ArcMap reference frame and DEM of 

Hawai‘i.  The DEM (Digital Elevation Model) were obtained in October 2014 as NED 1/3 (~10 

meter) dataset. DEM were projected in ArcGIS under WGS (World Geodetic System) 1884 UTM 

(Universal Transverse Mercator) Zone 4N.  The DEM for the entire state were downloaded as 14 

separate files, which had to be stitched together with the Mosaic tool in ArcMap (Appendix D).  

From the stitched DEM, geomorphologic variables were computed for the nine currently gaged 

streams on Maui, as well as nine ungaged streams on Maui, which will be used to predict the 

hydrological values of those streams.     

http://water.usgs.gov/GIS/metadata/usgswrd/XML/sir2014-5168_Maui_water-budget_components.xml
http://water.usgs.gov/GIS/metadata/usgswrd/XML/sir2014-5168_Maui_water-budget_components.xml
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2.2.a Stream Network 

Before computing geomorphologic variables, I had to create a stream network for Maui, and 

therefore had to determine the cell accumulation threshold.  I determined the cell 

accumulation threshold and stream network using two different methods – a general island 

method and a watershed-specific method.  Rea and Skinner (2012) used two different cell 

accumulation thresholds, which has been used by other papers.  Rea and Skinner created a 

dense stream network with a 900-cell threshold (x = 2.954) to display delineation and a 

sparse stream network with a 20,000-cell threshold (x = 4.3) to define catchments.  In order to 

determine a general stream network for the entire island of Maui (Appendix E), I compared 

the stream network produced to a satellite-image basemap in ArcMap.  (Basemaps used in 

this thesis were created using ArcGIS® software by Esri. ArcGIS® and ArcMap™ are the 

intellectual property of Esri and are used herein under license. Copyright © Esri. All rights 

reserved. For more information about Esri® software, please visit www.esri.com.)   Stream 

networks were validated by comparison with satellite images where I was able to see lines of 

flowing water (Figure 13).  I therefore made a stream network to outline the currently flowing 

streams, and found that a 3,162-cell threshold (x = 3.5) created an average stream network for 

the entire island.   

 
Figure 13. Evidence of currently flowing streams while determining Method 1 stream network cell-

threshold. Streams on satellite basemap are interpreted as the faint white lines that flow through 

stream channels, which are then traced with blue lines to clearly visualize. Black lines are the stream 

network created with a 3162 cell-threshold (x=3.5). 

http://www.esri.com/
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In order to determine a watershed-specific stream network, cell accumulation thresholds were 

determined for each individual stream analyzed on the island of Maui.  The stream networks 

were created using the same methodology as explained in Appendix E, but I determined the 

specific cell accumulation threshold for each stream by comparing my stream to a stream 

network map created by the USGS based on a 10-meter DEM 

(http://streamstatsags.cr.usgs.gov/hi_ss/default.aspx?stabbr=hi&dt=1428991619089).  The 

stream densities I created were matched as closely as possible to the respective stream found 

on the USGS map.  With this method, cell accumulation thresholds ranged from 3,162 

(x=3.5) to 31,623 (x=4.5).    

2.2.b Drainage Density 

Drainage densities were computed by dividing the total stream length by the area of the 

drainage basin (Appendix F). 

2.2.c Hypsometric Integrals and Curves 

Hypsometric integrals were computed with the equation  

          𝐻𝐼 =  
𝑚𝑒𝑎𝑛 𝑒𝑙𝑒𝑣𝑎𝑡𝑖𝑜𝑛−𝑚𝑖𝑛𝑖𝑚𝑢𝑚 𝑒𝑙𝑒𝑣𝑎𝑡𝑖𝑜𝑛

𝑚𝑎𝑥𝑖𝑚𝑢𝑚 𝑒𝑙𝑒𝑣𝑎𝑡𝑖𝑜𝑛−𝑚𝑖𝑛𝑖𝑚𝑢𝑚 𝑒𝑙𝑒𝑣𝑎𝑡𝑖𝑜𝑛
                                       (5) 

where the elevations were determined as explained in Appendix G. 

 

2.2.d Concavity Index, θ 

Concavity indices were determined by plotting the watershed drainage area, A, against the 

channel slope percent rise to compute a power trendline equation  

𝑆 =  𝑘𝑠𝐴−𝜃              (6) 

where S is the channel slope, ks is the profile steepness, and θ is the concavity index 

(Zaprowski et al., 2005).  Methods to compute the slope and flow for the concavity index are 

explained in greater detail in Appendix H.  

2.3 Analysis 

2.3.a Predicting relative amounts of discharge 

The hydrologic and geomorphologic variables were calculated for the nine currently gaged 

streams on Maui.  It is not as easy to calculate the hydrologic variables for ungaged streams 

on the island because gaging stations are needed to collect streamflow statistics.  However, it 

is still possible to compute the geomorphologic variables of ungaged streams using the DEM 

http://streamstatsags.cr.usgs.gov/hi_ss/default.aspx?stabbr=hi&dt=1428991619089
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and ArcMap reference frame, which does not depend on the availability of stream gaging 

stations.  

 

In order to determine if a stream’s relative discharge can be predicted based on quantifiable 

hydrologic and geomorphologic variables, the calculated variables of the currently gaged 

streams were plotted against each other to determine the relationship between the hydrologic 

and geomorphologic features.  Recession constants, low-flow values, and change in storage 

values were plotted against drainage densities, hypsometric integrals, and concavity indices 

(where the geomorphologic variables were plotted on the x-axis and the hydrologic variables 

were plotted on the y-axis).  Each plot was fitted with a best-fit line and 95% confidence 

intervals (Appendix I and J).  The geomorphologic values computed from the currently gaged 

streams were plugged into the appropriate equations to determine the precision of the best-fit 

equation and to anticipate which relationships should provide the most accurate predictions.  

The geomorphologic values from the nine ungaged streams were then plugged into the 

appropriate best-fit equation to determine what recession constant, low-flow value, and 

change in storage value each geomorphologic variable would predict.  The predictions of 

each hydrologic variable were compared to each other to discover which geomorphologic 

variable(s) could be used to determine the most accurate hydrologic values.  

 

2.3.b Comparing Maui to O‘ahu 

The same analysis was carried out with streams on the island of O‘ahu to determine if the 

islands share similar relationships or if there is variability between each island within the 

state.  The same hydrologic and geomorphologic variables were calculated from stream 

discharge data for three currently gaged streams on O‘ahu.  Since O‘ahu has the same general 

lithology and climate system as Maui, the geomorphologic data were input into the same 

best-fit equations used for Maui’s predictions.  Those hydrological predictions were 

compared to the actual hydrological values to determine the accuracy of the predictions. 

 

2.3.c Evaluating groundwater sharing between watersheds 

To evaluate whether there is groundwater sharing between watersheds, the recharge values 

computed (Appendix B) were compared to the baseflow values computed (Appendix C).   
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3.  Results 

The overarching question of this thesis is whether streamflow conditions can be predicted based 

on relationships found between hydrologic and geomorphologic variables, and if these predictions 

can aid in determining which streams would be most ideal to gage in the future in order to receive 

the most water possible from groundwater resources.  To answer these questions, hydrologic and 

geomorphologic data was calculated for the nine currently gaged streams, five ungaged northern 

streams, and four ungaged southern streams on Maui (Figure 14 and 15).  I tested this method 

with three of the currently gaged streams on O‘ahu to determine if the method was applicable to 

different islands (Figure 16).  This study focused on three hydrologic variables and three 

geomorphologic variables in order to resolve if this method of streamflow condition management 

is possible.  
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Figure 14. Map of Maui displaying all of the drainage basins created with Method 1 stream networks. Known intermittent stream outlines are bolded. 

Areas of the island impounded by dikes are displayed with criss-crossed areas (dike outlines provided by M. Bassiouni, USGS, pers. comm. July 2014). 
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Figure 15. Map of Maui displaying all of the drainage basins created with Method 2 stream networks. Known intermittent stream outlines are bolded. 

Areas of the island impounded by dikes are displayed with criss-crossed areas (dike outlines provided by M. Bassiouni, USGS, pers. comm. July 2014). 
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Figure 16. Map of O‘ahu displaying all of the drainage basins analyzed in this thesis. The three currently gaged basins used in this study are 

outlined with purple. Areas of the island impounded by dikes are displayed with criss-crossed areas and areas with enigmatic groundwater 

occurrence are displayed with striped areas (dike outlines provided by M. Bassiouni, USGS, pers. comm. July 2014). 



32 
 

3.1  Hydrologic variables 

The hydrologic variables used in this thesis are recession constants, low-flow values, and change 

in storage values.   

3.1.a  Recession Constants, k 

The recession constant is the rate at which stream flow decreases as the stream is being recharged 

(Vogel and Kroll, 1996).  The lithology and aquifer properties of the drainage basins, therefore, 

influence the recession constants.  The recession constant, k, is derived from the discharge 

equation 𝑄 = 𝑄𝑜𝑒−𝛼𝑡 (Equation 1), where 𝑘 =  𝑒−𝛼 (Equation 2) (Thomas et al., 2013).  High 

recession constants typically correspond to settings of lower permeability, by causing the 

groundwater to discharge steadily into the stream network (Delwyn Oki, USGS, pers.comm. 

March 2015).  In this study, streams with recession constants greater than 0.95 were typically set 

in watersheds with at least 50% of its area impounded by less-permeable dikes (Table 1).  Low 

recession constants typically correspond to settings of higher permeability, causing the 

groundwater to discharge rapidly into the stream network and sometimes reducing the flow to 

zero.  In this study, streams with recession constants less than 0.95 were typically set in 

watersheds with less than 50% of its area impounded by less-permeable dikes (Table 1).  Related 

to that assessment, very low recession constants that are less than 0.90 correlated with 

intermittent streams (Table 1).  Since intermittent streams are seasonal and therefore only flow 

during certain times of the year (Bierman and Montgomery, 2014), the groundwater quickly 

discharges from the stream and drops to zero.  This is most likely caused by a change in hydraulic 

conductivity and a difference in the ability of the aquifer’s subsurface to transmit water (Bierman 

and Montgomery, 2014), resulting in a very low recession constant.  The recession constants 

alone are useful for water resource management because they can differentiate between perennial 

and intermittent streams.  In the case of potential water resources, intermittent streams are much 

less desirable due to the low discharge and baseflow expected from the stream.       
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Table 1. Calculated hydrologic variables for gaged and ungaged streams on Maui and O‘ahu. Hydrologic variables include recession constant (k), alpha value (), low-flow value (Q95), the percent 

of time water flows in a stream, average annual precipitation (P), average annual discharge (Q), average annual evapotranspiration (ET), and change in storage (∆S).  Dike-impoundment indicates 

what percent of the drainage basin is impounded by dikes and years used indicates the years used to calculate P, Q, ET, and ∆S.    
 

 

Stream USGS ID 
Dike-

impoundment 

(%) 

k  Q95 (cfs) P (in3/yr) Q (in3/yr) ET (in3/yr) ∆S (in3/yr) 

Years used 

for P, Q, 

ET, ∆S 

C
u

rr
en

tl
y

 g
ag

ed
 M

au
i 

st
re

am
s 

Honokōhau 16620000 100 0.962 0.039 11 4.82E+15 2.08E+12 7.16E+14 4.10E+15 ‘78-‘07 

Kahakuloa 16618000 100 0.957 0.044 4 1.72E+15 9.50E+11 4.66E+14 1.25E+15 ‘78-‘07 

Waihe‘e 16614000 100 0.982 0.018 33 5.37E+15 3.84E+12 9.28E+14 4.44E+15 ‘78-‘07 

‘Īao 16604500 100 0.956 0.045 16 9.33E+15 3.34E+12 1.82E+15 7.51E+15 ‘78-‘07 

Honopou 16587000 0 0.943 0.059 0.47 6.22E+13 2.54E+11 1.93E+13 4.27E+13 ‘78-‘07 

Waikamoi 16552800 96.87 0.855 0.157 1.65 6.38E+14 1.00E+11 2.61E+14 3.77E+14 ‘78-‘07 

West Wailuaiki 16518000 5.55 0.930 0.073 2.2 2.42E+15 1.81E+12 4.28E+14 1.99E+15 ‘78-‘07 

Hanawi 16508000 18.05 0.956 0.045 2.2 3.58E+15 1.26E+12 4.99E+14 3.08E+15 ‘78-‘07 

‘Ohe‘o 16501200 36.01 0.845 0.167 0.44 2.14E+16 2.74E+12 2.98E+15 1.84E+16 ‘78-‘07 

U
n

g
ag

ed
 

so
u

th
er

n
 M

au
i 

st
re

am
s 

Kahoma 16638500 69.45 - - - - - - - - 

Malalowaiaole 16647500 0 - - - - - - - - 

Kealia - 2.436 - - - - - - - - 

Unnamed 16664200 0 - - - - - - - - 

U
n

g
ag

ed
 n

o
rt

h
er

n
 

M
au

i 
st

re
am

s 

South Waiehu 205426156313601 100 - - - - - - - - 

Honolua 16623000 100 - - - - - - - - 

Makapipi 16507000 0 - - - - - - - - 

Kawaipapa 16502900 44.66 - - - - - - - - 

Ko‘olau 16523000 48.17 - - - - - - - - 

C
u

rr
en

tl
y

 

g
ag

ed
 O

ah
u

 

st
re

am
s 

Kalihi 16229000 3.626 0.938 0.064 0.68 1.42E+15 3.41E+11 6.31E+14 7.90E+14 ‘78-‘07 

Kamananui 16325000 91.17 0.830 0.187 0.01 1.65E+15 5.36E+11 5.28E+14 1.12E+15 ‘78-‘07 

Waikāne 16294900 100 0.979 0.021 3.8 1.11E+15 5.88E+11 3.80E+14 7.28E+14 ‘78-‘07 
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3.1.b  Low-flow Values, Q95 

Low-flow values are defined as Q95 values, the discharge at which the stream flow is expected to 

exceed 95% of the time.  In the case of water resources, higher Q95 values would be most 

desirable because they indicate that the stream has an overall larger discharge.  I found that the 

drainage basins that are completely impounded by dikes had the highest Q95 values compared to 

the drainage basins that were only partially impounded by dikes (Table 1 and Figure 17).  The Q95 

values were generally positively correlated to the recession constants (Figure 18), which will be 

further addressed in the discussion. 

Figure 17. Plot comparing percent of basin 

impounded by dikes to low-flow value, Q95. 

 

Figure 18. Plot comparing low-flow value, 

Q95, to mean recession constant. Note the 

general positive trend.  Purple markers 

indicate streams where k>0.95. Green markers 

indicate streams where k<0.95.  Triangle 

marker is Waihe‘e stream.   

 

3.1.c  Change in Storage, ∆S 

The change in storage of a drainage basin is the difference of the watershed’s precipitation, 

discharge, and evapotranspiration (Equation 4).  This value indicates how much water is lost to 

factors other than discharge and evapotranspiration, such as reservoirs, soil, lakes, etc. (Fetter, 

2000).  A larger change in storage value would not be ideal for water resource purposes because 

that indicates a lot of water is lost before it is able to drain to gage sites.  ∆S values for Maui 

streams were generally positively correlated to both the recession constant and Q95 values (Table 

1).  The ∆S values, however, did not have strong correlations to the percent of the basin that is 

impounded by dikes (Figure 19).  The ∆S values were generally positively correlated to the 

recession constants (Figure 20), which will be further addressed in the discussion. 
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Figure 19. Plot comparing percent of basin 

impounded by dikes to change in storage, ∆S. 

 

Figure 20. Plot comparing change in storage 

value, ∆S, to mean recession constant. Note 

the general positive trend. 

 

3.2 Geomorphic Variables 

Drainage density, hypsometric integral, and concavity index were the geomorphologic variables 

used in this thesis.  Unlike the hydrologic variables, streamflow gaging stations are not needed to 

calculate geomorphic characteristics.  The geomorphologic variables can instead be calculated 

with the DEM in ArcMap.  Therefore, the three geomorphologic variables were calculated for 

both the gaged and ungaged watersheds on the island of Maui (Table 2). 

3.2.a  Drainage Density 

The drainage density informs us of how much a watershed is cut by stream channels and how 

well the watershed is drained by the stream network (Bierman and Montgomery, 2014).  Drainage 

densities are calculated by dividing the total channel length by the total drainage area; high 

drainage densities indicate relatively evolved basins that are cut by numerous streams which drain 

the basin well, while low drainage densities indicate relatively young basins that do not contain 

many stream channels (Bierman and Montgomery, 2014).  Note that drainage densities do not 

correlate with the percent of the drainage basin that is impounded by dikes (Figure 21).  

 
Figure 21. Plots comparing percent of drainage basin impounded by dikes and drainage density. 

(a) Drainage densities calculated with Method 1. (b) Drainage densities calculated with Method 2.
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Table 2. Calculated geomorphologic variables for gaged and ungaged streams on Maui and O‘ahu.  Geomorphological variables include drainage basin area (km2), stream length (km), 

stream order (Strahler method), drainage density (dd), hypsometric integral (Hyps.Int.), and concavity index (θ).  Dike-impoundment indicates what percent of the drainage basin is 

impounded by dikes.  Stream length and drainage density are reported twice, based on the method used to determine cell accumulation threshold.  

 

Stream USGS ID 
Dike-imp 

 (%) 

Basin area 

(km2) 

Stream length  

Method 1 (km) 

Stream length 

Method 2 

(km) 

Stream 

order 

dd  

Method 1 

(/km) 

dd 

Method 2 

(/km) 

Hyps.Int. 

(dimension-

less) 

-θ 

C
u

rr
en

tl
y

 g
ag

ed
 M

au
i 

st
re

am
s 

Honokōhau 16620000 100 11.07 13.49 11.46 2 1.23 1.04 0.448 -0.532 

Kahakuloa 16618000 100 8.92 14.09 9.95 2 1.57 1.11 0.461 -0.425 

Waihe‘e 16614000 100 11.09 12.80 12.8 3 1.16 1.16 0.402 -0.485 

‘Īao 16604500 100 15.84 22.2 22.2 3 1.39 1.39 0.354 -0.442 

Honopou 16587000 0 1.53 2.71 0.91 1 1.36 0.45 0.545 0.448 

Waikamoi 16552800 96.87 6.43 14.35 2.83 3 2.39 0.47 0.545 -0.208 

West Wailuaiki 16518000 5.55 9.21 22.36 11.48 3 2.48 1.28 0.420 -0.397 

Hanawi 16508000 18.05 10.92 20.90 9.26 3 1.90 0.84 0.495 -0.41 

‘Ohe‘o 16501200 36.01 22.32 36.46 18.53 3 1.66 0.84 0.440 -0.29 

U
n

g
ag

ed
 

so
u

th
er

n
 M

au
i 

st
re

am
s 

Kahoma 16638500 69.45 13.16 23.15 15.75 2 1.76 1.18 0.454 -0.601 

Malalowaiaole 16647500 0 1.66 3.13 3.13 1 1.89 1.89 0.467 -0.273 

Kealia - 2.436 58.5 134.76 99.46 3 2.30 1.7 0.215 -1.048 

Unnamed 16664200 0 9.31 21.68 5.62 3 2.33 0.60 0.350 -0.379 

U
n

g
ag

ed
 n

o
rt

h
er

n
 

M
au

i 
st

re
am

s 

South Waiehu 205426156313601 100 2.63 3.11 3.11 1 1.18 1.18 0.376 -0.784 

Honolua 16623000 100 4.85 7.61 7.61 2 1.57 1.57 0.432 -0.167 

Makapipi 16507000 0 4.82 9.84 6.70 2 2.04 1.39 0.380 -0.546 

Kawaipapa 16502900 44.66 16.18 28.92 12.82 3 1.79 0.79 0.484 -0.262 

Ko‘olau 16523000 48.17 38.74 62.53 22.85 4 1.61 0.59 0.492 -0.206 

C
u

rr
en

tl
y

 

g
ag

ed
 O

ah
u

 

st
re

am
s 

Kalihi 16229000 3.626 6.64 1.98 1.98 1 0.298 0.298 0.328 -1.465 

Kamananui 16325000 91.17 8.12 7.51 7.51 1 0.924 0.924 0.440 -0.309 

Waikāne 16294900 100 5.79 1.56 1.56 1 0.270 0.270 0.298 -2.097 
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3.2.b  Hypsometric Integral 

The hypsometric integral indicates the degree of erosion of a drainage basin as well as the 

processes and factors controlling the formation of the basin (Sarp et al., 2011), while also 

describing the development stages of the watershed and its proneness to erosion processes (Singh, 

2008).  It indicates the amount of land mass found at different elevations; high hypsometric 

integrals are typical of younger basins, and low hypsometric integrals are typical of older basins 

(Bierman and Montgomery, 2014). When drainage densities and hypsometric integrals were 

plotted against each other (Figure 22), the relationships between the two variables differed 

depending on the method used to determine the stream network of the watersheds.  When 

drainage densities were calculated with Method 1 (whole-island stream network), they were 

positively correlated with the hypsometric integrals (Figure 22a).  When drainage densities were 

calculated with Method 2 (watershed-specific stream networks), they were inversely correlated 

(Figure 22b), just as was found by Bloomfield et al. (2011).  This relationship is as expected, due 

to the nature of hypsometric integrals explained earlier. 

 
Figure 22. Plots comparing drainage density against hypsometric integral. (a) Drainage densities 

calculated with Method 1 stream networks. (b) Drainage densities calculated with Method 2 

stream networks. Purple markers are streams with at least 50% of its watershed impounded by 

dikes. Green markers are streams with less than 50% of its watershed impounded by dikes.  Open 

markers (both purple and green) are intermittent streams. 

 

3.2.c  Concavity Index 

Concavity index values reflect the surface processes that are believed to have formed the stream 

and/or watershed (Bierman and Montgomery, 2014).  Lower concavity indices (<0.3) reflect 

steeper headwaters and debris flows; medium concavity indices (0.3 – 0.7) reflect streams that are 

typically dominated by fluvial incision; high concavity indices (>0.7) typically reflect alluvial 

rivers (Bierman and Montgomery, 2014). When concavity indices were plotted against Method 2 
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drainage densities and hypsometric integrals (Figure 23), the concavity indices were generally 

inversely correlated to drainage densities and positively correlated to hypsometric integrals. The 

different correlations are as expected based on the inverse relationship found between drainage 

density and hypsometric integrals (Figure 22b).  My data displays negative concavity index 

values because my stream profiles are all concave rather than convex (except for the anomaly, 

Honopou, which has been omitted from the graphs).  The more negative the concavity values are, 

the more concave the stream profiles are.  If streams are more concave, the drainage basins are 

potentially more eroded than convex streams, which I propose result in higher drainage densities, 

explaining the inverse relationship between negative concavity indices and drainage densities as 

seen in Figure 23a.     

 
Figure 23. Plots comparing concavity indices against drainage density and hypsometric integral.  

(a) Concavity indices plotted against Method 2 drainage densities.  (b) Concavity indices plotted 

against hypsometric integrals. In both graphs, Honopou stream has been omitted because it is the 

only convex stream with a positive concavity index value.  

 

3.3 Comparisons between hydrologic and geomorphologic variables 

The hydrologic and geomorphologic variables calculated from Table 1 and 2 were compared to 

determine if they share relationships that could potentially predict streamflow conditions. 

 

The relationship between drainage densities and mean recession constants of the nine currently 

gaged streams on Maui differed depending on the method used to determine the stream network 

and drainage density.  When a general stream network was created for the entire island, drainage 

densities had an inverse relationship with recession constants (Figure 24a, 24b). When stream 

networks were created for each watershed, drainage densities had a positive relationship with 

recession constants (Figure 24c, 24d).  These relationships will be analyzed further in the 

discussion section. 
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Figure 24. Plots comparing drainage density to mean recession constants.  (a) Plot comparing 

drainage densities calculated with Method 1 stream networks to mean recession constants of nine 

currently gaged streams on Maui. Note that the drainage density is generally inversely correlated 

to the recession constant, with Waikamoi Stream (open purple circle) and ‘Ohe‘o Gulch (open 

green circle) as the anomalies. (b) Plot comparing Method 1 drainage densities to mean recession 

constants of perennial streams with best-fit line. (c) Plot comparing Method 2 drainage densities 

to mean recession constants of nine currently gaged streams on Maui. (d) Plot comparing Method 

2 drainage densities to mean recession constants of perennial streams with best-fit line.  

 

 

The recession constants were also compared to the concavity indices and hypsometric integrals to 

determine the relationships between the variables.  Recession constants and concavity indices 

were found to have an inverse relationship and were generally divided by how much of the basin 

is impounded by dikes (Figure 25).  Basins with at least 50% of its area impounded by dikes had 

lower concavity indices and basins with less than 50% of its area impounded by dikes had higher 

concavity indices.  The main outlier is Honopou because it was the only stream with a positive 

concavity index, reflecting the convex shape of the stream profile. An inverse correlation was 

also found between the recession constants and hypsometric integrals (Figure 26).  When the low-

flow values were plotted against the hypsometric integrals, an inverse correlation was also found 

(Figure 27).  
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Figure 25. Plot comparing concavity indices to mean recession constants. Note that the concavity 

indices are inversely proportional to the recession constants, except for Honopou, which has a 

positive concavity index because the stream’s profile is convex.  Open markers (both purple and 

green) are intermittent streams. 

 

 

 
Figure 26. Plots comparing hypsometric integrals to mean recession constants.  (a) Plot including 

the two intermittent streams. Note that the hypsometric integrals are slight inversely proportional 

to the recession constant, with Waikamoi Stream (open purple circle) and ‘Ohe‘o Gulch (open 

green circle) as the anomalies.  Purple markers are streams with at least 50% of its watershed 

impounded by dikes. Green markers are streams with less than 50% of its watershed impounded 

by dikes.  Open markers (both purple and green) are intermittent streams. (b) Plot comparing 

hypsometric integrals to mean recession constants of perennial streams with best-fit line.  
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Figure 27. Plot comparing hypsometric integrals to Q95 values. Q95 values are considered low-

flow values of streams on Maui. Note that the hypsometric integrals are inversely proportional to 

the Q95 values. Purple markers are streams with at least 50% of its watershed impounded by 

dikes. Green markers are streams with less than 50% of its watershed impounded by dikes.  Open 

markers (both purple and green) are intermittent streams. 

 

 

 

 

 

 

Figure 28. Plots comparing 

drainage density to change in water 

storage, ∆S.  (a) Drainage densities 

calculated from Method 1 stream 

network. Note the slight inverse 

correlation.  (b) Drainage densities 

calculated from Method 2 stream 

networks. Note the positive 

correlation. Purple markers are 

streams with at least 50% of its 

watershed impounded by dikes. 

Green markers are streams with less 

than 50% of its watershed 

impounded by dikes.  Open markers 

(both purple and green) are 

intermittent streams.      
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Figure 29. Plot comparing hypsometric integrals to change in water storage, ∆S. Note that the 

hypsometric integrals are inversely proportional to ∆S, except for ‘Ohe‘o Gulch (open green 

circle).  Purple markers are streams with at least 50% of its watershed impounded by dikes. Green 

markers are streams with less than 50% of its watershed impounded by dikes.  Open markers 

(both purple and green) are intermittent streams. 

 

 

To predict the hydrologic values of currently ungaged streams on Maui, plots comparing drainage 

densities, concavity indices, and hypsometric integrals to recession constants, low-flow values, 

and change in storage values were fitted with 95% confidence intervals (Figure 30). The 

equations fit to the best-fit line and confidence intervals were used to recalculate the hydrologic 

variables for the currently gaged streams on Maui to evaluate the validity of the best-fit equations 

of each geomorphic variable.  The predictions are listed in Tables 3-5. 

 

 
Figure 30. Plot comparing drainage density against mean recession constants and 95% 

confidence intervals. Black circles are the actual values from currently gaged streams on Maui.  

Solid grey line is the best-fit line for the actual data, dashed black line is the upper limit 

confidence interval calculated based on the actual data, and dashed grey line is the lower limit 

confidence interval calculated based on the actual data. A linear equation was fit to the best-fit 

line to calculate the predicted recession constants of the ungaged streams and 6-order polynomial 

equations were fit to the upper and lower confidence intervals to determine the error bars of the 

predictions. All of the confidence interval plots can be found in Appendix J. 
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Table 3. Predicted recession constants (along with upper and lower standard deviations) of nine currently gaged streams of Maui, four ungaged streams of southern Maui, and five ungaged streams of northern Maui.  

Predicted recession constants were computed from best-fit line equation based on three different geomorphological variables (drainage density, concavity index, and hypsometric integral).  Upper and lower recession 
constants were computed from 95% confidence interval equations. Recession constants are dimensionless.  

    Drainage Density method Concavity Index method Hypsometric Integral method 

 Stream USGS ID Actual k Predicted k Upper SD Lower SD Predicted k Upper SD Lower SD Predicted k Upper SD Lower SD 

G
ag

ed
 S

tr
ea

m
s 

Honokōhau 16620000 0.962 0.939 0.981 0.896 0.991 1.016 0.965 0.934 0.985 0.883 

Kahakuloa 16618000 0.957 0.943 0.988 0.988 0.942 0.961 0.924 0.931 0.982 0.880 

Waihe‘e 16614000 0.982 0.947 0.994 0.944 0.969 0.991 0.948 0.947 1.004 0.889 

‘Īao 16604500 0.956 0.964 1.024 0.905 0.950 0.969 0.931 0.960 1.034 0.884 

Honopou 16587000 0.943 0.895 0.966 0.966 0.549 0.203 0.894 0.908 0.978 0.838 

Waikamoi 16552800 0.855 0.896 0.965 0.965 0.845 0.882 0.807 0.908 0.978 0.837 

West Wailuaiki 16518000 0.93 0.956 0.956 0.904 0.930 0.948 0.911 0.942 0.996 0.888 

Hanawi 16508000 0.956 0.924 0.968 0.880 0.936 0.954 0.917 0.922 0.976 0.867 

‘Ohe‘o 16501200 0.846 0.924 0.968 0.880 0.881 0.907 0.856 0.937 0.988 0.885 

  
  

S
o
u

th
er

n
 

U
n

g
ag

ed
 S

tr
ea

m
s Kahoma 16638500 - 0.949 0.996 0.902 1.022 1.056 0.987 0.933 0.984 0.882 

Malalowaiaole 16647500 - 1.002 1.111 0.892 0.874 0.902 0.846 0.929 0.980 0.878 

Kealia - - 0.988 1.077 0.899 1.223 1.336 1.111 0.997 1.160 0.835 

Unnamed 16664200 - 0.906 0.963 0.849 0.768 0.832 0.704 0.961 1.038 0.883 

N
o

rt
h
er

n
 U

n
g

ag
ed

 

S
tr

ea
m

s 

South Waiehu 205426156313601 - 0.949 0.996 0.902 1.104 1.169 1.039 0.954 1.020 0.888 

Honolua 16623000 - 0.978 1.053 0.902 0.826 0.871 0.781 0.939 0.991 0.886 

Makapipi 16507000 - 0.964 1.024 1.024 0.997 1.024 0.970 0.953 1.018 0.888 

Kawaipapa 16502900 - 0.920 0.965 0.965 0.869 0.898 0.839 0.924 0.977 0.872 

Ko‘olau 16523000 - 0.905 0.963 0.963 0.844 0.882 0.805 0.922 0.977 0.868 
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Table 4. Predicted low-flow values, Q95, (along with upper and lower standard deviations) of nine currently gaged streams of Maui, four ungaged streams of southern Maui, and five ungaged 

streams of northern Maui.  Predicted Q95 values were computed from best-fit line equation based on three different geomorphological variables (drainage density, concavity index, and hypsometric 

integral).  Upper and lower Q95 values were computed from 95% confidence interval equations. Q95 values are in cfs units. 

    Drainage Density method Concavity Index method Hypsometric Integral method 

 Stream USGS ID Actual Q95 Predicted Q95 Upper SD Lower SD Predicted Q95 Upper SD Lower SD Predicted Q95 Upper SD Lower SD 

G
ag

ed
 S

tr
ea

m
s 

Honokōhau 16620000 11 9.376 18.922 -0.171 17.183 31.636 2.669 8.779 18.515 -0.960 

Kahakuloa 16618000 4 10.456 20.333 0.578 10.467 21.054 -0.150 7.402 17.132 -2.329 

Waihe‘e 16614000 33 11.367 21.667 1.067 14.233 26.267 2.154 13.472 24.499 2.443 

‘Īao 16604500 16 15.250 28.632 1.867 11.534 22.328 0.705 18.436 32.796 4.074 

Honopou 16587000 0.47 -0.542 15.275 -16.36 -44.339 -241.324 152.681 -1.172 12.257 -14.604 

Waikamoi 16552800 1.65 -0.258 15.170 -15.69 -3.153 18.527 -24.836 -1.248 12.241 -14.740 

West Wailuaiki 16518000 2.2 13.309 24.910 1.707 8.710 19.318 -1.924 11.712 22.030 1.392 

Hanawi 16508000 2.2 5.999 15.792 -3.794 9.526 20.067 -1.043 3.945 14.409 -6.521 

‘Ohe‘o 16501200 0.44 5.999 15.792 -3.794 1.994 16.815 -12.837 9.639 19.467 -0.190 

  
  

S
o
u

th
er

n
 

U
n

g
ag

ed
 S

tr
ea

m
s Kahoma 16638500 - 11.756 22.273 1.238 21.514 41.115 1.826 8.210 17.923 -1.505 

Malalowaiaole 16647500 - 23.640 48.151 -0.872 0.927 16.964 -15.118 6.866 16.639 -2.909 

Kealia - - 20.483 40.380 0.585 49.570 113.279 -14.600 32.825 63.849 1.798 

Unnamed 16664200 - 1.965 14.686 -10.756 -13.829 22.647 -50.306 18.930 33.719 4.140 

N
o

rt
h
er

n
 U

n
g

ag
ed

 

S
tr

ea
m

s 

South Waiehu 205426156313601 - 11.737 22.243 1.230 33.000 69.818 -4.011 16.248 28.910 3.584 

Honolua 16623000 - 18.246 35.120 1.373 -5.726 19.996 -31.451 10.448 20.422 0.472 

Makapipi 16507000 - 15.233 28.598 1.868 18.062 33.424 2.634 15.832 28.211 3.451 

Kawaipapa 16502900 - 5.155 15.326 -5.016 0.236 17.126 -16.660 5.038 15.154 -5.081 

Ko‘olau 16523000 - 1.744 14.703 -11.216 -3.278 18.594 -25.154 4.279 14.626 -6.069 
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Table 5. Predicted change in storage, ∆S, (along with upper and lower standard deviations) of nine currently gaged streams of Maui, four ungaged streams of southern Maui, and five ungaged streams of 

northern Maui.  Predicted ∆S values were computed from best-fit line equation based on three different geomorphological variables.  Upper and lower ∆S values were computed from 95% confidence 

interval equations. ∆S values are in in3/yr. 

    Drainage Density method Concavity Index method Hypsometric Integral method 

 Stream USGS ID Actual ∆S 
Predicted 

∆S 
Upper SD Lower SD Predicted ∆S Upper SD Lower SD Predicted ∆S Upper SD Lower SD 

G
ag

ed
 S

tr
ea

m
s 

Honokōhau 16620000 4.10E+15 5.13E+15 7.38E+15 6.79E+15 1.43E+16 1.15E+17 -8.6E+16 6.56E+15 2.99E+16 1.14E+15 

Kahakuloa 16618000 1.25E+15 5.32E+15 6.93E+15 7.50E+15 1.33E+16 6.91E+16 -4.1E+16 6.16E+15 2.89E+16 1.83E+15 

Waihe‘e 16614000 4.44E+15 5.48E+15 6.57E+15 8.07E+15 1.39E+16 9.21E+16 -6.3E+16 7.93E+15 3.28E+16 -8.3E+14 

‘Īao 16604500 7.51E+15 6.17E+15 5.05E+15 1.05E+16 1.34E+16 7.48E+16 -4.7E+16 9.37E+15 3.57E+16 -2.7E+15 

Honopou 16587000 4.27E+13 6.63E+15 1.41E+16 -2.24E+15 4.52E+15 -2.49E+17 2.61E+17 3.66E+15 2.01E+16 9E+15 

Waikamoi 16552800 3.77E+14 3.41E+15 1.38 E+16 -1.91E+15 1.11E+16 4.04E+16 -1.7E+16 3.64E+15 2.0E+16 9.1E+15 

West Wailuaiki 16518000 1.99E+15 5.83E+15 5.82E+15 9.28E+15 1.30E+16 6.08E+16 -3.4E+16 7.41E+15 3.17E+16 -1.3E+14 

Hanawi 16508000 3.08E+15 4.53E+15 9.09E+15 4.28E+15 1.31E+16 6.45E+16 -3.7E+16 5.15E+15 2.61E+16 3.98E+15 

‘Ohe‘o 16501200 1.84E+16 4.53E+15 9.09E+15 4.28E+15 1.19E+16 4.27E+16 -1.7E+16 6.81E+15 3.05E+16 7.45E+14 

S
o
u

th
er

n
 

U
n

g
ag

ed
 S

tr
ea

m
s Kahoma 16638500 - 5.55E+15 6.42E+15 8.32E+15 1.50E+16 1.59E+17 -1.3E+17 6.39E+15 2.95E+16 1.42E+15 

Malalowaiaole 16647500 - 7.66E+15 -8.02E+14 1.84E+16 1.17E+16 4.15E+16 -1.7E+16 6.00E+15 2.85E+16 2.12E+15 

Kealia - - 7.1E+15 2.13E+15 1.47E+16 1.95E+16 7.45E+17 -7.1E+17 1.36E+16 4.51E+16 -9.4E+15 

Unnamed 16664200 - 3.81E+15 1.19E+16 5.08E+14 9.38E+15 4.92E+16 -2.8E+16 9.51E+15 3.59E+16 -2.9E+15 

N
o

rt
h

er
n
 U

n
g

ag
ed

 

S
tr

ea
m

s 

South Waiehu 205426156313601 - 5.55E+15 6.42E+15 8.30E+15 1.68E+16 3.27E+17 -2.9E+17 8.73E+15 3.44E+16 -1.9E+15 

Honolua 16623000 - 6.70E+15 3.60E+15 1.27E+16 1.07E+16 4.18E+16 -1.9E+16 7.05E+15 3.10E+16 3.91E+14 

Makapipi 16507000 - 6.17E+15 5.06E+15 1.05E+16 1.45E+16 1.23E+17 -9.4E+16 8.61E+15 3.41E+16 -1.7E+15 

Kawaipapa 16502900 - 4.38E+15 9.61E+15 3.56E+15 1.16E+16 4.10E+16 -1.6E+16 5.47E+15 2.71E+16 3.22E+15 

Ko‘olau 16523000 - 3.77E+15 1.21E+16 2.76E+14 1.11E+16 4.04E+16 -1.7E+16 5.25E+15 2.64E+16 3.74E+15 
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The actual hydrologic values of the nine currently gaged streams were plotted against the 

predicted hydrologic values to reveal which geomorphologic variable would produce the most 

accurate results (Figures 31-33). For clearer visualization, the differences between the actual and 

predicted values can be found in Appendix K. 

 

 
Figure 31. Plot comparing the predicted recession constants of the nine currently gaged streams on Maui. 

Recession constant symbology is coordinated according to the geomorphologic parameter used to compute 

the predicted recession constant. The predictions are compared to the actual recession constant (closed 

black circle) for each stream. Error bars were calculated from the 95% confidence interval equations and 

are color coordinated to the geomorphologic parameter. Stream data is organized in order of Table 3’s 

gaged streams [1.Honokōhau; 2.Kahakuloa; 3.Waihe‘e; 4 ‘Īao; 5.Honopou; 6.Waikamoi; 7.West Wailuaiki; 

8.Hanawi; 9. ‘Ohe‘o]. 

 

 
Figure 32. Plot comparing the predicted Q95 (low-flow) values of the nine currently gaged streams on 

Maui. Q95 symbology is coordinated according to the geomorphologic parameter used to compute the 

predicted Q95. The predictions are compared to the actual Q95 (closed black circle) for each stream.  Error 

bars were calculated from the 95% confidence interval equations and are color coordinated to the 

geomorphologic parameter. Stream data is organized in order of Table 4’s gaged streams [1.Honokōhau; 

2.Kahakuloa; 3.Waihe‘e; 4.‘Īao; 5.Honopou; 6.Waikamoi; 7.West Wailuaiki; 8.Hanawi; 9. ‘Ohe‘o]. 
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Figure 33. Plot comparing the predicted change in storage, ∆S, values of the nine currently gaged 

streams on Maui. ∆S symbology is coordinated according to the geomorphologic parameter used 

to compute the predicted ∆S. The predictions are compared to the actual ∆S (closed black circle) 

for each stream. Note that ∆S values predicted from drainage density and hypsometric integral 

variables were the closest to the actual ∆S. Error bars were calculated from the 95% confidence 

interval equations and are color coordinated to the geomorphologic parameter. Stream data is 

organized in order of Table 5’s gaged streams [1.Honokōhau; 2.Kahakuloa; 3.Waihe‘e; 4.‘Īao; 

5.Honopou; 6.Waikamoi; 7.West Wailuaiki; 8.Hanawi; 9. ‘Ohe‘o]. 

 

 

 

I then compared the predicted recession constants, Q95 values, and ∆S values based on all three 

geomorphologic variables to determine which geomorphologic variable would produce the most 

accurate prediction (Figures 34-36).  Figures 34-36 generally show that the predictions calculated 

based on drainage densities and hypsometric integrals produced similar results.  In most 

situations, the values calculated based on concavity indices are outliers.    
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Figure 34. Plot comparing the predicted recession constants from Table 3 of the nine ungaged 

streams on Maui. Stream numbers along x-axis are coordinated to numeric value assigned in the 

table. Recession constant symbology is coordinated according to geomorphologic parameter used 

to compute the predicted recession constant. Note the very similar recession constant values 

between the drainage density and hypsometric integral predictions. Stream data is organized in 

order of Table 3’s ungaged streams [1.Kahoma; 2.Malalowaiaole; 3.Kealia; 4.Unnamed; 5.South 

Waiehu; 6.Honolua; 7.Makapipi; 8.Kawaipapa; 9.Ko‘olau], where streams 1-4 are on the 

southern side of the island and streams 5-9 are on the northern side of the island. 

 

 

 
Figure 35. Plot comparing the predicted Q95 (low-flow) values from Table 4 of the nine ungaged 

streams on Maui. Stream numbers along x-axis are coordinated to numeric value assigned in the 

table.  Q95 symbology is coordinated according to geomorphologic parameter used to compute the 

predicted recession constant. Note the general similarity in Q95 values between drainage density 

and hypsometric integral predictions. Stream data is organized in order of Table 4’s ungaged 

streams [1.Kahoma; 2.Malalowaiaole; 3.Kealia; 4.Unnamed; 5.South Waiehu; 6.Honolua; 

7.Makapipi; 8.Kawaipapa; 9.Ko‘olau], where streams 1-4 are on the southern side of the island 

and streams 5-9 are on the northern side of the island. 
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Figure 36. Plot comparing the predicted change in storage values, ∆S, from Table 5 of the nine 

ungaged streams on Maui. Stream numbers along x-axis are coordinated to numeric value 

assigned in the table. ∆S symbology is coordinated according to geomorphologic parameter used 

to compute the predicted recession constant. Note the general similarity in ∆S values between 

drainage density and hypsometric integral predictions. Stream data is organized in order of Table 

5’s ungaged streams [1.Kahoma; 2.Malalowaiaole; 3.Kealia; 4.Unnamed; 5.South Waiehu; 

6.Honolua; 7.Makapipi; 8.Kawaipapa; 9.Ko‘olau], where streams 1-4 are on the southern side of 

the island and streams 5-9 are on the northern side of the island. 

 

 

 

 

 

I then carried out the same methods for three currently gaged streams on O‘ahu.  The actual and 

predicted hydrologic values for the three streams are displayed in Table 6.  The predictions 

calculated for each hydrologic variable based on all three geomorphologic variables are displayed 

in Figures 37-39.  Drainage densities and hypsometric integrals from the streams on O‘ahu 

produced hydrologic predictions similar to those of the streams on Maui, and the concavity 

indices also produced predictions displayed as outliers. 
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Table 6. Predicted recession constants (k), low-flow values (Q95), and change in storage (∆S) values of three currently gaged streams of O‘ahu. Predicted values were computed 

from best-fit line equation based on three different geomorphological variables (drainage density, concavity index, and hypsometric integral) of currently gaged streams on Maui. 

Upper and lower values were computed from 95% confidence interval equations. Recession constants are dimensionless, Q95 values are in cfs units, and ∆S are in in3/yr. 

 Drainage Density method Concavity Index method Hypsometric Integral method 

Stream USGS ID Actual k Predicted k Upper SD Lower SD Predicted k Upper SD Lower SD Predicted k Upper SD Lower SD 

Kalihi 16229000 0.938 1.008 1.118 0.897 1.411 2.462 0.360 0.967 1.055 0.878 

Kamananui 16325000 0.830 0.973 1.040 0.907 0.890 0.914 0.866 0.936 0.988 0.885 

Waikāne 16294900 0.979 1.009 1.122 0.897 1.696 23.712 -20.32 0.975 1.081 0.869 

            

 Actual Q95 Predicted Q95 Upper SD Lower SD Predicted Q95 Upper SD Lower SD Predicted Q95 Upper SD Lower SD 

Kalihi 16229000 0.68 25.77 49.94 1.607 75.74 674.3 -524.1 21.12 38.00 4.249 

Kamananui 16325000 0.01 17.68 32.22 3.133 3.186 16.81 -10.45 9.612 19.44 -0.214 

Waikāne 16294900 3.80 26.14 50.74 1.541 115.4 12678 -12451 24.20 44.41 3.978 

            

 Actual ∆S Predicted ∆S Upper SD Lower SD Predicted ∆S Upper SD Lower SD Predicted ∆S Upper SD Lower SD 

Kalihi 16229000 7.90E+14 8.40E+15 2.70E+16 -6.6E+15 2.37E+16 2.60E+18 -2.6E+18 1.02E+16 3.73E+16 -3.8E+15 

Kamananui 16325000 1.12E+15 7.15E+15 2.00E+16 -8.5E+14 1.21E+16 4.45E+16 -1.9E+16 6.80E+15 3.04E+16 7.57E+14 

Waikāne 16294900 7.28E+14 8.46E+15 2.73E+16 -6.8E+15 3.00E+16 2.07E+19 -2.1E+19 1.10E+16 3.92E+16 -5.2E+15 
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Figure 37. Plot comparing the predicted recession constants of three currently gaged streams on 

O‘ahu. Recession constant symbology is coordinated according to the geomorphologic parameter 

used to compute the predicted recession constant. The predictions are compared to the actual 

recession constant (closed black circle) for each stream. Error bars were calculated from the 95% 

confidence interval equations and are color coordinated to the geomorphologic parameter. 

 

 

 
Figure 38. Plot comparing the predicted Q95 (low-flow) values of three currently gaged streams 

on O‘ahu. Q95 symbology is coordinated according to the geomorphologic parameter used to 

compute the predicted Q95. The predictions are compared to the actual Q95 (closed black circle) 

for each stream.  Error bars were calculated from the 95% confidence interval equations and are 

color coordinated to the geomorphologic parameter. 
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Figure 39. Plot comparing the predicted change in storage, ∆S, values of three currently gaged 

streams on O‘ahu. ∆S symbology is coordinated according to the geomorphologic parameter used 

to compute the predicted ∆S. The predictions are compared to the actual ∆S (closed black circle) 

for each stream. Error bars were calculated from the 95% confidence interval equations and are 

color coordinated to the geomorphologic parameter. 

 

 

To assess my second question of whether hydrologic and/or geomorphic variables can recognize 

groundwater sharing between Waihe‘e and ‘Īao streams, I used the variables calculated for the 

first question and focused specifically on whether Waihe‘e and ‘Īao’s values were particularly 

prominent. 

 

 

Table 7. Recharge and baseflow values for the nine currently gaged streams on Maui.  Note that 

Waihe‘e and Honopou are the only streams that have a higher baseflow value than recharge 

value. 

Stream Recharge (cfs) Baseflow (cfs) Baseflow/recharge (%) 

Honokōhau 38.80 17.46 45.0 

Kahakuloa 15.42 6.722 43.6 

Waihe‘e 28.47 45.41 159.1 

‘Īao 35.86 27.59 76.9 

Honopou 1.539 1.957 127.2 

Waikamoi 7.607 0.074 0.97 

West Wailuaiki 21.46 6.918 32.24 

Hanawi 48.92 5.437 11.1 

‘Ohe‘o 94.23 2.782 2.95 
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Figure 40. Hypsometric curve plot comparing normalized cumulative area of watershed against 

normalized elevation. Purple lines are streams that belong to watersheds with at least 50% of its 

area impounded by dikes. Green lines are streams that belong to watersheds with less than 50% of 

its area impounded by dikes. Note that Waihe‘e’s hypsometric curve (bolded purple) strays away 

from the other curves, which are all generally clustered together.  Also note that although not as 

drastic as Waihe‘e, ‘Īao’s hypsometric curve (bolded dashed purple) lies between Waihe‘e’s 

curve and the other curves. 

 

 

 
Figure 41. Plot comparing baseflow/recharge with change in storage. Note the  

lack of correlation between the two variables. 
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4. Discussion 

The goal of this thesis is to use Maui as a case study to determine which streams produce the 

most ideal groundwater resources by analyzing relationships between hydrologic and 

geomorphologic variables of a watershed.  This thesis then used O‘ahu as a test case to determine 

if this analysis can produce valid results for other islands in Hawai‘i.  The geomorphologic 

variables used were drainage density, hypsometric integral, and concavity index.  The hydrologic 

variables used were recession constants, low-flow values, and change in storage values.   

4.1 Comparisons between hydrologic and geomorphologic variables 

The three hydrologic variables were compared to the three geomorphologic variables to 

determine if it is possible to predict streamflow conditions based on the geomorphologic 

characteristics of a drainage basin.  Two different methods were used to determine stream 

networks, and after calculating the drainage densities with both stream network methods, I 

realized how important the cell-accumulation threshold is while calculating the drainage density.  

When I used Method 1 to determine one general stream network for the entire island, some of the 

watersheds’ drainage densities were not as realistic as they should have been.  The drainage 

densities on the eastern side of the island were too high because the stream network included 

artificial streams.  This is obvious when the streams were matched against the hillshade of the 

island (Figure 14), because streams from the stream network were laid over relatively flat land.  

Since the drainage densities of half the watersheds were too high, this caused a positive 

correlation between drainage densities and hypsometric integrals (Figure 22a).  When I used 

Method 2 to create a stream network for individual watersheds to match the USGS’s stream 

network, the drainage densities inversely correlated with the hypsometric integrals (Figure 22b).  

This inverse correlation is more logical than the relationship found with the Method 1 

calculations because lower hypsometric integrals reflect relatively evolved basins while lower 

drainage densities reflect relatively young basins.  Based on the relationships found between 

drainage densities and hypsometric integrals, I propose that the drainage densities created with 

Method 2 stream networks are the most realistic.  The relationship makes sense considering the 

general definitions of what drainage densities and hypsometric integrals reflect (Bierman and 

Montgomery, 2014).  This relationship also matches the relationship found between drainage 

densities and hypsometric integrals in a study conducted by Bloomfield et al. (2011). 

The drainage densities computed with Method 1 and Method 2 stream networks were then 

compared to the recession constants of the streams.  The drainage densities calculated with the 
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Method 1 stream network were inversely correlated to the recession constants of the watersheds 

(Figure 24a, 24b).  This contradicts the relationship found by Brandes et al. (2005).  However, 

this is because Brandes et al. (2005) defines their recession constant as , whereas I defined my 

recession constant as  𝑘 =  𝑒−𝛼 (Equation 2).  When my recession constants, k, were converted to 

 (Table 1), the recession constants and  values became inversely related, and the drainage 

density and  values were positively correlated, just as Brandes et al. (2005) found.  The drainage 

densities calculated with the Method 2 stream networks were found to be positively correlated to 

the recession constants of the watersheds (Figure 24c, 24d), which now disagrees with Brandes et 

al. (2005).  Despite the fact that our results are not correlated in the same way, the Brandes et al. 

(2005) study is set in a different location with different geologic and climatic conditions, so it is 

difficult to properly compare their results to mine, especially since recession constants are not 

influenced solely by drainage density.  If the positive correlation between recession constants and 

drainage densities is true, then I propose the relationship could be explained as follows: higher 

recession constants reflect basins that are typically of lower permeability (i.e. dikes).  If a basin 

has a lower permeability, then the water is more likely to accumulate above the material of lower 

permeability since it is not easily able to seep down into the ground.  If more water accumulates 

at or near the surface, a larger volume of water exerts concentrated pressure on the surface, 

eroding deep incisions into the mountain slopes, and eventually creating steep valleys.  The steep 

valleys narrow the area of the drainage basins because the volume of water is concentrated in the 

valleys rather than widely flowing over the basin.  These narrow drainage basins are clearly 

identifiable in Figure 15.  Since drainage density is the total stream length divided by the total 

drainage area, the narrowed drainage basin areas result in a higher drainage density.  This 

indicates a positive correlation between recession constants and drainage densities, which I 

propose could explain the relationship seen in Figure 24c and 24d. 

Concavity index values reflect the surface processes hypothesized to have formed the stream 

channels and drainage basins (Bierman and Montgomery, 2014).  A stream’s recession constant 

was found to be inversely related to the concavity index of the stream (Figure 25).  The more 

negative the concavity index, the more concave the stream profile will be, whereas streams with a 

positive concavity index have a convex stream profile.  This correlation can also be supported by 

the proposed interpretation explaining the relationship between recession constants and drainage 

densities.  If a stream has a high recession constant, its basin is of lower permeability.  If the basin 

is of lower permeability, then water is more likely to accumulate at the surface of the basin and 

cut deep incisions into the landscape.  If this process is true, then the deep incisions would result 
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in stream profiles of greater concavity.  Therefore, I propose that these profiles will result in 

lower concavity indices.  This then results in an inverse correlation between recession constants 

and concavity indices.    

Hypsometric integrals provide information of the erosional extent of a drainage basin as well as 

the processes and factors controlling the formation of the basin (Sarp et al., 2011).  The 

hypsometric integral describes the development stages of the watershed and its susceptibility to 

erosional processes (Singh, 2008). The values also indicate the amount of land mass found at 

different elevations, where high hypsometric integrals are typical of younger basins and low 

hypsometric integrals are typical of older basins (Bierman and Montgomery, 2014).  A stream’s 

mean recession constant, k, and low-flow value, Q95, were observed to be inversely related to the 

hypsometric integral of the watershed (Figure 26 and 27).  The erosion of a watershed is greatly 

affected by surface runoff and sediment loss, which hypsometric integrals indicate (Singh, 2008).  

If a watershed has a high Q95 value, that means the watershed has a large discharge with lots of 

runoff.  If there is more runoff, then more erosion can occur, generating a lower hypsometric 

integral, which is in agreement with the relationship between Q95 values and hypsometric 

integrals in Figure 27. 

A stream’s change in storage, ∆S, is the amount of water lost to factors other than discharge and 

evapotranspiration, such as reservoirs, lakes, soil, etc. (Fetter, 2000).  When drainage densities 

were calculated with Method 1 stream networks, the drainage density was inversely correlated to 

a stream’s change in storage, ∆S (Figure 28a).  When drainage densities were calculated with 

Method 2 stream networks, the drainage density was positively correlated to ∆S (Figure 28b).  If 

a watershed has a large drainage density, water is flowing over longer distances through longer 

streams.  If water is flowing over longer distances, there are more opportunities for the water to 

leave the stream network and increase the ∆S value.  It then makes sense, that the ∆S values are 

positively correlated to the drainage density of a watershed using Method 2 stream networks.  If 

the positive correlation is true, I propose it is possible that drainage densities indicate the relative 

amount of ∆S of watersheds.  This explanation also reinforces my belief that the drainage 

densities calculated with the Method 2 stream networks are most reliable.   

I also found the change in storage value, ∆S, to be inversely correlated to the hypsometric integral 

of the watershed (Figure 29), which should be as expected since hypsometric integrals and 

drainage densities are inversely correlated (Figure 22b) and drainage densities and change in 

storage values are positively correlated (Figure 28b).  As mentioned earlier, high hypsometric 
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integrals reflect younger basins and low hypsometric integrals reflect older, heavily eroded basins 

(Bierman and Montgomery, 2014).  If a basin is heavily eroded, then there are potentially more 

reservoirs for water to escape to, therefore increasing the ∆S value.  If a basin is young, it will 

typically have a lower stream order (Table 2).  If a basin has a lower stream order, then water 

flows through less tributaries, therefore providing less opportunities for the water to be lost along 

the way.  If there are fewer ways for water to be lost within the drainage basin, then I suspect the 

change in storage value should be lower.  A watershed with a large ∆S may not be desirable for 

water resources because a lot of the precipitation it receives is lost before it can be collected for 

use.  The ∆S value, of course, must be analyzed in relation to the overall amount of precipitation 

a watershed receives.  A watershed with a high ∆S value but also a very high precipitation level 

could still discharge more water than a watershed with a low ∆S value and a low precipitation.  

Even though stream orders were calculated for these streams, they are not the most distinguishing 

characteristic to analyze because there was little difference between stream orders since most of 

the streams in the drainage basins are relatively young (Table 2).  

4.2  Predicting hydrologic variables  

The relationships found between the hydrologic and geomorphologic variables of the gaged 

streams are used to predict the unknown hydrologic variables of the ungaged streams on Maui.  

Each geomorphologic variable of the nine currently gaged Maui streams was plotted against each 

hydrologic variable of the nine currently gaged Maui streams in order to determine a best-fit 

equation and 95% confidence interval equations (Figure 30 and Appendix J), which could then be 

used to calculate predicted hydrologic values of the ungaged streams (Tables 3-5).   

4.2.a  Comparing actual vs predicted hydrologic variables of currently gaged streams on Maui 

The actual hydrologic values were compared to the predicted hydrologic values of the nine 

currently gaged streams on Maui (Figures 31-33).  Out of the three geomorphologic variables 

analyzed, drainage densities and hypsometric integrals produced the most accurate hydrologic 

predictions for ungaged streams.   

The recession constants of Honokōhau and Honopou were accurately predicted with the 

watershed’s drainage density, ‘Īao was most accurately predicted with the hypsometric integral, 

and Kahakuloa, Waihe‘e, Waikamoi, Hanawi, and ‘Ohe‘o were most accurately predicted with 

the concavity index (Figure 31).  Despite the observation that most recession constants were most 

accurately predicted from the concavity index, the concavity index values also produced some of 
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the largest standard deviations relative to the standard deviations produced by drainage densities 

and hypsometric integrals.  The large standard deviations could be because of the concavity 

index’s lack of basin area sensitivity.  Since channels with different gradients could have the 

same concavity index, the relationships including concavity indices could be weak, resulting in 

larger standard deviations.  The groups of streams predicted by each geomorphologic variable do 

not have the same external characteristics in common (i.e. location, basin area, average 

precipitation), which suggests that there is no particular reason why certain geomorphologic 

variables were able to better predict the recession constants of certain streams.  The lack of 

consistency of which geomorphologic variables produce the best recession constant predictions 

may be due to the fact that recession constants cannot be analyzed based on individual 

geomorphologic variables.  As mentioned in the introduction, recession constants are complex 

and can be affected by various factors.  The recession constants are dependent not only on the 

geomorphology of the drainage basin, but on the general hydrology of the basin and time as well.  

All of these factors could affect the predictions made and therefore result in a lack of consistency 

amongst the geomorphologic variables.  

While comparing the actual low-flow values, Q95, with the predicted Q95, there was no clear 

geomorphic variable that produced the most accurate predictions, but the hypsometric integral 

produced the most predictions closest to the actual Q95 (Figure 32).  The standard deviations 

calculated for the Q95 values were all relatively similar, except for Honopou, which had a very 

large concavity index standard deviation.  While comparing actual ∆S values with the predicted 

∆S values, it was found that the drainage densities and hypsometric integrals produced the most 

accurate values compared to the concavity indices (Figure 33).  In this case, the drainage densities 

had some of the smallest standard deviations and the concavity indices had some of the largest 

standard deviations, therefore making the concavity indices less reliable than the drainage density 

and hypsometric integral predictions.   

Based on the comparisons made between the actual data and the predicted data for the nine 

currently gaged streams on Maui, the drainage densities and hypsometric integrals of the 

watersheds should provide the best insight into predicting recession constants, low-flow values, 

and change in storage values for the ungaged streams.  Since drainage densities and hypsometric 

integrals have a strong inverse correlation (Figure 22b), it is understandable why both variables 

prove to be ideal indicators of hydrologic variables rather than one over the other.  The drainage 

density and hypsometric integral ultimately quantify the same characteristic of a watershed – 

landscape dissection – but measure it in different ways.  They should ideally be treated as the 
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same variable rather than two separate attributes, explaining the similar predictions calculated by 

both variables.  The predictions calculated based on drainage densities and hypsometric integrals 

were closest in accuracy to the actual hydrologic values and typically had the smallest standard 

deviations, making them more precise relative to the predictions calculated based on concavity 

indices.   

4.2.b  Predicting hydrologic variables of ungaged Maui streams 

Based on the comparisons of actual and predicted hydrologic values of the nine currently gaged 

streams on Maui, the drainage density and hypsometric integral of the watersheds should produce 

relatively accurate predictions of the hydrologic variables of Maui’s ungaged streams.  The 

hypothesis that drainage densities and hypsometric integrals of a watershed would produce 

relatively accurate hydrologic variable predictions was true in all three cases of predicting 

recession constants, low-flow values, and change in storage values for the nine ungaged streams 

on Maui.  When predicting the hydrologic variables for the ungaged basins, I found that the 

drainage densities and hypsometric integrals produced similar results relative to the concavity 

indices (Figures 34-36).  With the ungaged streams, actual recession constants, low-flow values, 

and change in storage values were not calculated because the streams’ discharges are no longer 

monitored.  Therefore, the actual values were not used to verify the validity of the predictions, as 

was done with the currently gaged streams in section 4.2.a.  Since the hydrologic predictions 

computed from the drainage density equation were similar to the predictions computed from the 

hypsometric integral equation (Figures 34-36), I propose that those predicted hydrologic variables 

are most accurate to what the actual hydrologic variables would be.  The concavity index may not 

be the best geomorphologic parameter to use while predicting hydrologic variables of ungaged 

streams because unlike the hypsometric integrals, the concavity indices are not sensitive to basin 

size.  Both a large and small watershed could have the same concavity index, but for different 

reasons.  The large watershed could have a low concavity index because the stream is heavily 

eroded to the point where its profile is very concave.  A small watershed could have a low 

concavity index because its short length causes the slope to increase.  Even though both streams 

have similar concavity indices, their basin areas are different, which I suspect could impact the 

amount of water that is discharged from the stream.  Concavity index interpretations are 

debatable since the values are affected by various factors such as, rate of uplift, base level, and 

climate (Zaprowski et al., 2005).  In contrast, the drainage density and hypsometric integral take 

basin size into account, and thus produce more representative values.  The drainage densities and 
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hypsometric integrals are affected by surficial and underground water processes that are reflected 

in the results (Singh, 2008).      

The five ungaged streams on the northern side of the island (Figure 15) were predicted to have 

less variability between the three geomorphologic variables compared to the ungaged streams on 

the southern side of the island (Figure 15).  This is likely because the ungaged streams on the 

northern side of the island are most similar to the currently gaged streams.  Since the streams are 

located on the northern side, they receive the same general amount of annual precipitation (Figure 

2) and experience the same general climatic changes.  It is interesting that the hydrologic 

predictions were most consistent with watersheds that are impounded by dikes.  In Figures 31-33, 

streams 1, 5, and 6 have at least 50% of their watersheds impounded by dikes, and streams 8 and 

9 have at least 44% of their watersheds impounded by dikes. The predictions computed based on 

drainage densities and hypsometric integrals are very close to each other for those streams, 

suggesting that along with those two geomorphologic variables, watersheds with dike-impounded 

groundwater, or that have a lower permeability, can potentially provide more accurate hydrologic 

predictions.     

Based on these variables, it is challenging to determine which streams would have the most ideal 

streamflow conditions because Q95 and ∆S are both positively correlated to the recession 

constant, k (Figures 18 and 20).  In section 4.1.a, higher recession constants typically indicate 

perennial streams (rather than intermittent), so it is now necessary to determine whether high or 

low Q95 and ∆S values are preferable.  Since Q95 values indicate the value at which the flow is 

expected to exceed 95% of the time, then higher Q95 values are desirable since they should 

correlate with larger discharges.  Low ∆S values are desirable because if a stream has a large ∆S, 

then the stream is losing a lot of water to unknown reservoirs before reaching the gaging station.  

However, if you look for a high Q95 value to give you a high k value, you could also have a high 

∆S value, since both are positively correlated to k.  It is then perhaps best to look for k values that 

are somewhere in the middle (perhaps ranging between 0.925-0.96), and balance between a large 

low-flow value and a small change in storage value.  

For the island of Maui, it seems that the streams on the northern side of the island have the most 

ideal streamflow conditions since they receive the most precipitation and have recession constants 

predicted to be within the range of 0.925-0.96.  The northern streams on the western side of the 

island are predicted to have higher low-flow values, suggesting higher water discharge values.  

However, the northern streams on the eastern side of the island had lower change in storage 

values, which are preferable since they suggest that high volumes of water are not shared.  The 
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northwestern streams have higher ∆S values, but if groundwater sharing is indeed occurring 

between Waihe‘e and ‘Īao stream (which are located on the northwest side of the island), it is 

possible that groundwater sharing could be happening between other streams located near 

Waihe‘e and ‘Īao.  Therefore, even though the groundwater is being lost from a stream with a 

high ∆S value, that groundwater could be escaping to an adjacent watershed, from which water 

can still be collected as water resources. 

4.2.c  Predicting hydrologic variables of streams on O‘ahu 

Hydrologic predictions were computed for three currently gaged streams on O‘ahu (Table 6) to 

determine if the same conclusions could be made for other islands in Hawai‘i or if the above 

conclusions are restricted only to Maui.  The predictions and standard deviations computed for 

O‘ahu are very high compared to the actual values.  In general, it seems that the hypsometric 

integral and drainage density produced the closest predictions, especially compared to the 

predictions computed from the concavity indices, but those predictions are still much higher than 

the actual values (Figures 37-39).  I propose that it is indeed possible to predict streamflow 

conditions of O‘ahu’s ungaged streams under the same methods used to predict streamflow 

conditions of Maui’s ungaged streams in this thesis.  However, it does not seem appropriate to 

use the same equations to predict the hydrologic variables between islands.  Even though the 

islands all experience the same general climate systems and have the same general lithology, 

slight differences in environmental and anthropogenic conditions can greatly impact the 

calculations and predictions.  For example, O‘ahu is much more heavily populated than Maui, has 

a lower maximum elevation, and is older in age, which should be reflected by mountains more 

eroded than Maui (Engott et al., 2015).  All of these factors could impact the way the 

groundwater flows throughout the watersheds. Therefore, in order to best predict the streamflow 

conditions of O‘ahu’s ungaged streams, it would be ideal to calculate best-fit equations for O‘ahu 

based on discharge values of O‘ahu’s streams rather than Maui’s streams. 

Based on the results from this thesis, the geomorphologic variables can indeed be used to estimate 

the hydrologic characteristics of a drainage basin.  Studies such as Bloomfield et al. (2011) found 

that if relationships can be determined and quantified between the lithology, hydrology, and 

geomorphology of an area, then those physical characteristics can be used to estimate the 

hydrologic features of ungaged basins.  Results from this thesis could be used for other areas 

within Hawai‘i and around the world, but with caution.  Even though the hydrology of an area is 

related to its geomorphology, every area is unique.  There are many factors that influence a 
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watershed’s hydrology, so it is possible for relationships to vary.  Overall, the general 

relationships found between the geomorphologic and hydrologic variables should be relatively 

similar in other locations, but as seen with the Brandes et al. (2005) study, relationships can vary, 

especially when it comes to the recession constants.  Since recession constants are time-

dependent, not as easily determined as other hydrologic characteristics (such as low-flow values), 

and have a relatively small range, there is a higher chance that the recession constants will have 

different relationships with other features of the drainage basins.  Therefore, extra precaution 

should be taken while calculating recession constants; not only because of their sensitivity, but 

because of their usefulness while estimating streamflow conditions.  Bevans (1986) found that 

under certain conditions, recession constants can be used to estimate aquifer properties.  By 

analyzing baseflow recession curves, you are able to determine stream-aquifer interactions 

without necessarily having to use digital groundwater flow models, which can be very expensive 

and difficult to operate (Bevans, 1986).  If recession constants can be calculated for streams, the 

recession constants can potentially identify perennial and intermittent streams, therefore 

suggesting the stream’s usefulness as a water resource.  

4.3 Groundwater Sharing 

The main components likely to identify groundwater sharing were the recharge and baseflow 

values calculated for each watershed.  Table 7 shows that Honopou had a higher baseflow than 

recharge value, but I suspect that is because Honopou is an anomaly rather than a stream with 

groundwater sharing.  Honopou has a very small basin area relative to the other watersheds, is 

isolated from the other gaged streams, and does not necessarily receive as much rainfall as the 

other watersheds (Figure 2).  So, I suspect that Honopou’s characteristics are too dissimilar from 

the other watersheds to confidently say that it is experiencing groundwater sharing.  Table 7 also 

shows that Waihe‘e Stream has a larger baseflow than recharge value, indicating that Waihe‘e is 

receiving water from another source.  It is expected that Waihe‘e is receiving groundwater from 

‘Īao, which is adjacent to Waihe‘e, although most hydrologic and geomorphic variables did not 

show strong evidence of this.   

The only other parameter that showed slight evidence of groundwater sharing is the hypsometric 

curve.  Figure 40 shows that Waihe‘e stream’s curve is more concave and strays away from the 

rest of the curves, which could indicate evidence of groundwater sharing.  A concave hypsometric 

curve reflects a watershed with a greater amount of its rock volume located lower in the basin, 

whereas a convex hypsometric curve reflects a watershed with a greater amount of its rock 
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volume located higher in the basin (Bierman and Montgomery, 2014).  If the curve is concave, 

then more material has been eroded and transported downstream.  If a stream receives more 

groundwater from groundwater sharing, then I suspect that the larger volume of water can erode 

more material, resulting in a concave hypsometric curve.  This could explain why Waihe‘e’s 

hypsometric curve is the most concave relative to the eight other hypsometric curves in Figure 40.  

The issue now, is understanding why ‘Īao’s hypsometric curve is so concave when it is 

supposedly losing groundwater to Waihe‘e.  I would assume that if a stream is losing a lot of its 

water, it will not be able to erode as much material, resulting in a convex hypsometric curve.  

However, ‘Īao receives more precipitation than Waihe‘e (Table 1), so perhaps ‘Īao can afford to 

lose some of its groundwater to Waihe‘e while still eroding and transporting material downstream 

to result in a concave hypsometric curve.  This explains how a stream receiving extra water and a 

stream losing water could both have concave hypsometric curves, and suggest that hypsometric 

curves could indeed detect possible groundwater sharing between watersheds.  However, since 

Waihe‘e and ‘Īao are the only streams with potential groundwater sharing, it is difficult to 

conclude whether the hypsometric curves are indicative of this process, or if it is just a 

coincidence that Waihe‘e’s curve strays.  

I also looked at how the baseflow/recharge values compared to the change in storage values, ∆S, 

(Figure 41) because the change in storage could possibly relate to groundwater sharing.  As 

mentioned earlier, if streams have higher ∆S values, the streams are losing a lot of water to 

unknown reservoirs.  That reservoir could be another watershed.  If ∆S reflects groundwater 

sharing, then streams with high baseflow/recharge values should correlate to low ∆S values, 

therefore indicating that the streams are on the receiving-end of the sharing.  However, when 

plotted, Figure 41 lacked sufficient evidence that ∆S could be an indicator of groundwater 

sharing.  The data did not have a strong correlation between the two variables and it is difficult to 

determine if they actually share an inverse relationship.  Since a correlation is not seen between 

baseflow/recharge and change in storage values, the groundwater sharing may be occurring on a 

smaller local scale.  I suggest that it would be best to analyze smaller portions of the island to 

search for localized groundwater sharing.       
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5.  Summary and Conclusions 

The main objective of this thesis was to determine if Maui’s streamflow conditions could be 

predicted based on quantifiable hydrologic and geomorphologic variables.  Hydrologic variables 

such as baseflow recession constants (k), low-flow values (Q95), and change in storage (∆S) were 

computed for currently gaged streams on Maui and analyzed against computed geomorphologic 

variables such as drainage density, hypsometric integral, and concavity index.  The relationships 

found between the hydrologic and geomorphologic variables were used to predict the hydrologic 

values of ungaged basins on Maui in order to determine the potential streamflow conditions of 

those ungaged streams.  The analysis was then carried over to O‘ahu to determine if the same 

relationships between hydrologic and geomorphologic variables could be used for O‘ahu’s 

watersheds.   

When recession constants were computed for the island of Maui, I found that streams with 

recession constants greater than 0.95 were generally located in areas of the island with dike-

impounded groundwater and streams with recession constants less than 0.95 were generally 

located in areas with groundwater that is not dike-impounded.  Streams with recession constants 

less than 0.90 are expected to be intermittent or nearly perennial streams because the stream 

discharge is very low and sometimes drops to zero.  Recession constants could be useful for water 

resource management because the recession constants can predict the streamflow conditions 

(whether a stream is perennial or intermittent) which could indicate whether a stream is ideal for 

water resources.  

When the actual hydrologic values were compared to the predicted hydrologic values of the 

currently gaged streams on Maui, I found that the drainage densities and hypsometric integrals 

produced the most accurate predictions.  The same was found for the ungaged Maui streams, 

where the drainage densities and hypsometric integrals generally produced the most similar 

hydrologic predictions.  The similarity between drainage density and hypsometric integral 

predictions is due to the fact that the two variables ultimately measure the same watershed 

characteristic (landscape dissection), but in different ways.  The northern ungaged streams had 

the least amount of variability relative to the southern ungaged streams, most likely because the 

currently gaged streams are also located on the northern side of the island, therefore are placed 

under similar environmental and climatic conditions as the currently gaged streams.   

I propose that the same analysis conducted on Maui can also be done for the island of O‘ahu.  The 

drainage densities and hypsometric integrals produced hydrologic predictions most similar to the 
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actual hydrologic values, relative to the concavity indices.  However, since the differences 

between the actual and predicted hydrologic values were much greater than those of Maui, the 

slight environmental and anthropogenic differences between Maui and O‘ahu may affect the 

results of the analysis.  Therefore, it would be most ideal to use relationships found on O‘ahu in 

order to predict the streamflow conditions.     

The second objective of this thesis was to determine if the hydrologic and geomorphologic 

variables can predict/explain potential groundwater sharing between adjacent watersheds.  

However, since there was a lack of known watersheds that share groundwater, conclusive 

evidence was not found.  Recharge and baseflow values seemed to be the best indicators since 

basins with larger baseflow values than recharge values indicates that the stream is receiving 

water from other sources besides precipitation recharge.  Hypsometric curves show potential for 

determining if groundwater sharing is occurring, due to the intense concavity of streams that 

receive extra groundwater.  Change in storage values could also reflect groundwater sharing, but 

due to the lack of correlation between ∆S and baseflow/recharge, this hypothesis should be 

further explored on a smaller, localized scale.   

This thesis concludes that relationships between a watershed’s hydrologic and geomorphologic 

characteristics can be used to predict streamflow conditions, and that drainage densities and 

hypsometric integrals have the potential to estimate hydrologic variables.  This thesis calculates 

the baseflow recession constants of Maui streams, which has never been done for the state of 

Hawai‘i, and uses those values, along with whole-scale basin parameters to assess the relationship 

between the island’s hydrology and geomorphology.  These assessments can be used to predict 

potential streamflow conditions, which are critical for the island’s water resource management.  
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Appendix A: Median Discharge, Q95 Exceedance Percentile, and Flow-Duration Curves 

1. Input all of the discharge values of one stream into a single column in an Excel sheet.  

The discharge data should be the same continuous data used for the same years as the 

recession constants. 

2. Sort the discharge values from largest to smallest. 

3. In a new column, assign a rank to each value (where the largest value is 1) 

4. For each value, calculate the Weibull plotting position m/(n+1), where m is the rank and 

n is the total number of values. 

5. If trying to determine the median discharge, search for the Weibull number that is closest 

to 0.5. 

6. If trying to determine the Q95 exceedance percentile, search for the Weibull number that 

is closest to 0.95. 

7. This method can be used to plot flow duration curves. 
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Appendix B: Converting Recharge from in/yr to cfs 

1. In ArcMap, clip mean annual water-budget components file provided by the USGS Pacific 

Islands Water Science Center (http://water.usgs.gov/GIS/metadata/usgswrd/XML/sir2014-

5168_Maui_water-budget_components.xml) according to the desired watersheds.  

2. Calculate the area (in square meters) of each polygon within the watershed by adding a 

new variable in the attribute table and calculating geometry. 

3. Copy the data from the attribute table and paste in an Excel file. 

4. Calculate the new recharge in cfs of each polygon with the equation 

recharge/12/86400/365*area*10.7639, where the recharge in the equation is in in/yr and 

the area is in m2. 

5. You can then add all of the new recharge values within the entire watershed to get the total 

recharge of the watershed in cubic feet per second.  

 

Appendix C: Computing Baseflow with Wahl and Wahl program (1995) 

(files provided by the USGS Pacific Islands Water Science Center c/o Adam Johnson) 

1. Instructions to run the Wahl and Wahl (1995) program, provided by the USGS 

a. Run bfi415.exe 

i. Input is the .crd file that contains streamflow data from NWIS (i.e. 

st16614000.crd [for Waihe‘e Stream].  Bfi415.exe and .crd file must be 

in the same folder. 

ii. Choose ‘h’ to name output hydrograph file. Choose ‘f’ (use 0.9). Choose 

‘N’ (use 1). Program output files will be st16614000.q, st16614000.bfi, 

st16614000.n. 

b. Run bfigetn.exe to get rid of text in output file st16614000.q 

i. Input: st16614000.q 

ii. Output: st16614000notext.q 

c. Run bfigetn.exe program to select only streamflow and baseflow values for the N 

that you specify (i.e. 1) 

i. Input .crd file: (i.e. st1614000.crd) 

ii. Input no text file: (i.e. st16614000notext.q) 

iii. Input N value: (i.e. 3; this varies by station, so please see table 4 of 

Johnson et al. (2014) report (SIR-2014-5168 

http://water.usgs.gov/GIS/metadata/usgswrd/XML/sir2014-5168_Maui_water-budget_components.xml
http://water.usgs.gov/GIS/metadata/usgswrd/XML/sir2014-5168_Maui_water-budget_components.xml
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[http://pubs.usgs.gov/sir/2014/5168/pdf/sir2014-5168.pdf]) to determine 

N value for each stream). 

iv. Output file: (i.e. st16614000n3.q) 

2. Calculate annual average baseflow 

a. Import data from .q file (i.e. st16614000n3.q) into an Excel file 

b. Calculate the average baseflow of each water year (October 1 – September 30) 

and average all of the averages to get the annual average baseflow.  Baseflow 

values are in cfs.  

 

Appendix D: Using the Mosaic tool in ArcGIS 

The Mosaic tool in ArcGIS is used to stitch multiple rasters into a single raster. 

1. Stitch the rasters together: 

a. ArcToolbox > Raster > Raster Dataset > Mosaic to New Raster 

b. Input rasters: select all of the rasters you wish to stitch together 

c. Output location: choose a location for your file 

d. Raster Dataset Name with Extension: whatever you choose to name your fully 

stitched raster and follow the extension instructions on the right 

e. Number of Bands: 1 

 

Appendix E: Creating a Stream Network in ArcGIS 

1. Fill your DEM to eliminate empty cells: 

a. ArcToolbox > Spatial Analyst > Hydrology > Fill 

b. Input: [your initial DEM (i.e. Maui_dtm)] 

c. Output: [whatever you choose to name your filled layer (i.e. Maui_dtm_fill)] 

2. Inform GIS which direction the water in the stream is flowing: 

a. ArcToolbox > Spatial Analyst > Hydrology > Flow Direction 

b. Input: [your filled layer (i.e. Maui_dtm_fill)] 

c. Output: [whatever you choose to name your flow direction layer (i.e. 

Maui_FlowDir)] 

3. Determine how many cells should be counted upstream from drainage area: 

a. ArcToolbox > Spatial Analyst > Hydrology > Flow Accumulation 
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b. Input: [your flow direction file (i.e. Maui_FlowDir)] 

c. Output: [whatever you choose to name your flow accumulation file (i.e. 

Maui_FlowAcc)] 

d. Output data type: INTEGER (saves space) 

4. Calculate the log of the flow accumulation: 

a. ArcToolbox > Spatial Analyst > Map Algebra > Raster Calculator 

b. Double-click “Log10” from menu on right of Raster Calculator screen 

c. Double-click your flow accumulation file under Layers and variables menu on 

left 

d. Output: [whatever you choose to name your new flow accumulation file (i.e. 

log10_FlowAcc)] 

5. Determine cell-threshold: 

a. ArcToolbox > Spatial Analyst > Map Algebra > Raster Calculator 

b. Double-click your new flow accumulation file (i.e. log10_FlowAcc) from the left 

menu 

c. Double-click “>=” symbol 

d. Type in 3.5 

e. Output: [whatever you choose to name your stream network file (i.e. 

Maui_strm_3p5)] 

6. Link intersections of streams: 

a. ArcToolbox > Spatial Analyst > Hydrology > StreamLink 

b. Input stream raster: [your stream network file (i.e. Maui_strm_3p5)] 

c. Input flow direction raster: [your flow direction file (i.e. Maui_FlowDir)] 

d. Output: [whatever you choose to name your stream link file (i.e. 

Maui_strmL_3p5)] 

7. Convert the streams into a feature: 

a. ArcToolbox > Spatial Analyst > Hydrology > Stream to Feature 

b. Input: [your stream link file (i.e. Maui_strmL_3p5)] 

c. Output: [whatever you choose to name your stream feature (i.e. 

Maui_strmF_3p5)] 
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Appendix F: Drainage Density 

1. Creating Watershed Boundary 

a. If not already displayed, open the Drawing menu (Customize > Toolbars > Draw) 

b. Select Marker option from the Drawing toolbar  

c. Place a marker on the cell of interest on your stream (my marker was placed as 

close to the gaging station as possible since that was the lowest point at which 

incoming water could have been measured) 

d. Create the pour point by converting the marker to feature from the Drawing 

pulldown menu (Drawing > Convert Graphics to Features) and save it as a layer 

to the map (i.e. Waihee_pp).  Once the marker is a layer on the map, you can 

delete the original marker, which should be displayed above the feature.  

e. Create watershed 

i. ArcToolbox > Hydrology > Watershed 

ii. Input flow direction raster: [your flow direction file (i.e. Maui_FlowDir)] 

iii. Input raster or feature pour point data: [your marker feature (i.e. 

Waihee_pp)] 

iv. Output raster: [whatever you choose to name your watershed raster (i.e. 

Waihee_ws)] 

f. Convert watershed to shapefile 

i. ArcToolbox > Conversion Tools > From Raster > Raster to Polygon 

ii. Input raster: [your watershed raster (i.e. Waihee_wtrshd) 

iii. Output polygon features: [whatever you choose to name your watershed 

(i.e. Waihee_watershed)] 

2. Calculate Drainage Basin Area 

a. Right-click your watershed layer (i.e. Waihee_watershed) > Open Attribute 

Table 

b. Click Table Option pulldown menu > Add Field 

i. Name: Area 

ii. Type: Double (gives a more precise value) 

c. If not already displayed, open Editor toolbar (Customize > Toolbars > Editor) 

d. Click Editor > Start Editing 

e. In the Start Editing window, find and select the layer you want to edit (i.e. 

Waihee_waterhsed) (Be sure the same layer is selected from the Create Features 

sidetab) 
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f. Right-click Area title cell in Attribute Table > Calculate Geometry 

i. Property: Area 

ii. Units: Square Kilometers [sq km] 

g. The area of the drainage basin will be displayed in the Attribute Table in square 

kilometers 

3. Extract Streams within Watersheds 

a. ArcToolbox > Spatial Analyst Tools > Extract by Mask 

b. Input raster: [your stream network file (i.e. Maui_strmF_3p5)] 

c. Input raster or feature mask data: [your watershed shapefile (i.e. 

Waihee_watershed)] 

d. Output raster: [whatever you choose to name your extracted stream (i.e. 

Waihee_extract)] 

4. Calculate Stream Length 

a. Right-click your extracted stream layer (i.e. Waihee_extract) > Open Attribute 

Table 

b. Click Table Option pulldown menu > Add Field 

i. Name: Length 

ii. Type: Double (gives a more precise value) 

c. Click Editor > Start Editing > select layer you want to edit (i.e. Waihee_extract) 

d. Right-click Length title cell in Attribute Table > Calculate Geometery 

i. Property: Length 

ii. Units: Kilometers [km] 

e. The length of the extracted streams will be displayed in the Attribute Table in 

kilometers 

5. Calculate Drainage Density 

a. Divide stream length by drainage basin area (I chose to do this in Excel) 

Appendix G: Hypsometric Integral 

(Reproduced from instructions found at http://gis4geomorphology.com/hypsometric-index-integral/). 

1. Convert DEM mosaic from floating point to integer 

a. Spatial Analyst > Math > Int 

b. Input raster or constant value: the DEM mosaic 

c. Output raster: whatever you choose to name it 

http://gis4geomorphology.com/hypsometric-index-integral/
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2. Extract by mask: extract the new integer DEM for each watershed 

3. Reclassify the new watersheds 

a. Spatial Analyst > Reclassify 

b. Input raster: the new watershed shapefile 

c. Classify > Method: Equal Interval > Classes: 20 

d. Output raster: name_hyprec 

4. Open the properties of the reclassified watershed and take note of the mean, max, and min 

elevation. 

5. HI = (mean elevation – min elevation)/(max elevation – min elevation) 

 

Appendix H: Channel Concavity Index 

(Reproduced from instructions found at http://gis4geomorphology.com/concavity-soon/). 

1. Create a point marker at the headwaters of the stream trunk and covert graphic to feature 

(i.e. Waihee_cpp) 

2. Mark out the stream trunk 

a. Spatial Analyst > Cost Path 

b. Input raster or feature destination data: your new point (i.e. Waihee_cpp) 

c. Input cost distance raster: your flow accumulation (i.e. flowacc) 

d. Input cost backlink raster: your flow direction (i.e. flowdir) 

e. Output raster: save it [Waihee_trunk] 

3. Clip out only the trunk within your drainage basin 

a. Spatial Analyst > Extract by Mask 

b. Input raster: Waihee_trunk 

c. Input raster or feature mask data: your watershed shapefile (i.e. 

Waihee_watershed.shp) 

d. Output raster: Waihee_trcl 

4. Extract DEM from trunk 

a. Spatial Analyst > Extract by Mask 

b. Input raster: your filled DEM (i.e. full_mosaic) 

c. Input raster or feature mask data: Waihee_trcl 

d. Output Raster: Waihee_t.dem 

5. Determine slope of the trunk 

a. Spatial Analyst > Slope 
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b. Input raster: Waihee_t.dem 

c. Output raster: Waihee_t.slope 

d. Output measurement: PERCENT_RISE 

6. Extract flow of the trunk 

a. Spatial Analyst > Extract by Mask 

b. Input raster: flowacc 

c. Input raster or feature mask data: Waihee_trcl 

d. Output raster: Waihee_t.flow 

7. Get points from trunk 

a. Conversion > From Raster > Raster to Point 

b. Input raster: Waihee_trcl 

c. Output point features: Waihee_t.points 

8. Extract slope to points 

a. Spatial Analyst > Sample 

b. Input rasters: Waihee_t.slope 

c. Input location raster or point features: Waihee_t.points 

d. Output table: Waihee_slope_data 

e. Open the table that is created; copy the data from the table and paste into Excel 

9. Extract flow to points 

a. Spatial Analyst > Sample 

b. Input rasters: Waihee_t.flow 

c. Input location raster or point features: Waihee_t.points 

d. Output table: Waihee_flow_data 

e. Open the table that is created; copy the data from the table and paste into Excel 

i. Cut the flow data column and paste it next to the slope data column from 

earlier (you can delete the other data from the flow section since it’s the 

same as the slope section). 

10. Making a channel concavity plot 

a. Delete all rows where the slope is zero 

b. Create a new column titled “drainage area” and fill it with the equation 

=(flow*(pixel size*pixel size))/1000000 

c. Plot drainage area on x-axis and slope on y-axis (with both axes on log scale) 

d. Fit a power trend line and display the line’s equation 

e. The concavity index is the exponent of the equation 
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Appendix I: Calculating 95% Confidence Intervals 

(95% confidence intervals were calculated based on instructions found at  

http://www.tushar-mehta.com/publish_train/data_analysis/16.htm). 

 

1. Let’s say we want to compare drainage 

density (x-axis) with recession constants (y-

axis).  Add your drainage density and 

recession constant data as two columns in 

Excel and graph it with a best-fit line; 

display the equation of the best-fit line.  

Make note of the slope (m) and y-intercept 

(b) of the best fit line in the Excel sheet.    

 

 

2. Calculate ŷ, the value predicted 

for each x value, with the 

equation ŷ=mx+b, where m is 

the slope of the best-fit line, x 

is the drainage density value, 

and b is the y-intercept of the 

best-fit line. Calculate the 

residual (error), y-ŷ, where y is 

the recession constant.  Then, 

square the residual to get (y-

ŷ)2.  Calculate SS, which is the 

sum of all the (y-ŷ)2 values (the 

sum of the values that remain 

unexplained) with the equation 

=SUM((y-ŷ)2). 

 

http://www.tushar-mehta.com/publish_train/data_analysis/16.htm
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3. Plug in the appropriate value for n, 

which is the number of rows of actual 

data, and k, which is the number of 

columns of actual data. Calculated the 

degrees-of-freedom, df, which is the 

difference between n and k.  Calculate 

the standard error of the regression, 

SE, with the equation SE = √
𝑆𝑆

(𝑛−𝑘)
.  

Calculate the critical t-value, t, with 

the formula =TINV(0.05,df), where 

0.05 is the probability that 

corresponds to the 95% confidence. 

 

 

4. Make a new column in Excel with a list of “predictable” drainage densities from which 

you wish to predict recession constants.  In the next column, calculate the predicted 

recession constants with the best-fit line equation mx1+b, where x1 is the “predictable” 

drainage density you just typed in. 
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5. Calculate the distance of the confidence interval with the equation, CI, with the equation  

 CI =  (t)(SE)√
1

[COUNT(x:x)+(x1−AVERAGE(x:x))]2

DEVSQ(x:x)

, where COUNT, AVERAGE, and DEVSQ 

are functions in Excel, x1 is each “predicted” drainage density value, and x:x is the range 

of actual drainage density values.  Calculate the lower CI by subtracting the CI from the 

“predicted” recession constant (i.e. J3=H3-I3 in the Excel sheet).  Calculate the upper CI 

by adding the CI with the “predicted” recession constant (i.e. K3=H3-I3 in Excel).  

 

 

6.  Against the predicted drainage densities, graph the predicted recession constants, lower 

CI values, and upper CI values.  You can add a trendline and display the equations.  For 

the lower and upper CI trendlines, I found that a 6-order polynomial line matched best.  

You should have a graph with three lines that looks similar to the graphs displayed in 

Appendix J. 
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Appendix J: 95% Confidence Interval Graphs 

 

 

 

y = 0.0746x + 0.8608

R² = 1

y = 0.0025x6 - 0.0311x5 + 0.1463x4 - 0.302x3 + 0.1928x2 + 0.1428x + 0.7418

R² = 0.9991

y = -0.0025x6 + 0.0311x5 - 0.1463x4 + 0.302x3 - 0.1928x2 + 0.0064x + 0.9798

R² = 0.9999

6.00E-01

7.00E-01

8.00E-01

9.00E-01

1.00E+00

1.10E+00

1.20E+00

1.30E+00

1.40E+00

0 0.5 1 1.5 2 2.5 3 3.5 4

m
ea

n
 r

ec
es

si
o
n

 c
o
n

st
an

t

drainage density

y = -0.451x + 0.7507

R² = 1

y = -0.9234x6 - 1.4371x5 + 0.8256x4 + 2.4022x3 + 1.0108x2 - 0.4692x + 0.6848

R² = 1

y = 0.9234x6 + 1.4371x5 - 0.8256x4 - 2.4022x3 - 1.0108x2 - 0.4328x + 0.8166

R² = 1

0.6

0.7

0.8

0.9

1

1.1

1.2

1.3

1.4

-1.1 -0.9 -0.7 -0.5 -0.3 -0.1 0.1

m
ea

n
 r

ec
es

si
o
n

 c
o
n

st
an

t

concavity index

y = -0.2704x + 1.0554

R² = 1

y = -22.232x6 + 61.491x5 - 59.897x4 + 23.438x3 - 3.7339x2 + 0.5648x + 0.7551

R² = 0.9992

y = 22.232x6 - 61.491x5 + 59.897x4 - 23.438x3 + 3.7339x2 - 1.1056x + 1.3557

R² = 0.999

0.4

0.5

0.6

0.7

0.8

0.9

1

1.1

1.2

1.3

1.4

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

m
ea

n
 r

ec
es

si
o
n

 c
o
n

st
an

t

hypsometric integral



81 
 

 

 

 

y = 16.881x - 8.2145

R² = 1

y = 0.5523x6 - 6.9419x5 + 32.671x4 - 67.428x3 + 43.052x2 + 32.106x - 34.779

R² = 0.9992

y = -0.5523x6 + 6.9419x5 - 32.671x4 + 67.428x3 - 43.052x2 + 1.6556x + 18.35

R² = 0.9999

-4.00E+01

-2.00E+01

0.00E+00

2.00E+01

4.00E+01

6.00E+01

8.00E+01

1.00E+02

0 0.5 1 1.5 2 2.5 3 3.5 4

Q
9

5

drainage density

y = -62.765x - 16.208

R² = 1

y = -527.14x6 - 820.44x5 + 471.32x4 + 1371.4x3 + 577.03x2 - 73.145x - 53.833

R² = 0.9992

y = 527.14x6 + 820.44x5 - 471.32x4 - 1371.4x3 - 577.03x2 - 52.385x + 21.417

R² = 0.9998

-60

-40

-20

0

20

40

60

80

100

120

-1.1 -0.9 -0.7 -0.5 -0.3 -0.1 0.1

Q
9

5

concavity index

y = -103.08x + 54.961

R² = 1

y = -4244.3x6 + 11739x5 - 11435x4 + 4474.5x3 - 712.84x2 + 56.362x - 2.3707

R² = 0.9997

y = 4244.3x6 - 11739x5 + 11435x4 - 4474.5x3 + 712.84x2 - 262.52x + 112.29

R² = 0.9996

-60

-40

-20

0

20

40

60

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

Q
9
5

hypsometric integral



82 
 

 

 

 

y = 3E+15x + 2E+15

R² = 1

y = 3E+14x6 - 4E+15x5 + 2E+16x4 - 4E+16x3 + 3E+16x2 + 1E+16x - 1E+16

R² = 0.9997

y = -3E+14x6 + 4E+15x5 - 2E+16x4 + 4E+16x3 - 3E+16x2 - 6E+15x + 2E+16

R² = 0.9999

-3.00E+16

-2.00E+16

-1.00E+16

0.00E+00

1.00E+16

2.00E+16

3.00E+16

4.00E+16

5.00E+16

0 0.5 1 1.5 2 2.5 3 3.5 4

ch
an

g
e 

in
 s

to
ra

g
e

drainage density

y = -1E+16x + 9E+15

R² = 1

y = -6E+17x6 - 9E+17x5 + 5E+17x4 + 2E+18x3 + 6E+17x2 - 2E+16x - 3E+16

R² = 0.9988

y = 6E+17x6 + 9E+17x5 - 5E+17x4 - 2E+18x3 - 6E+17x2 + 2E+15x + 5E+16

R² = 0.9992

-6E+16

-4E+16

-2E+16

0

2E+16

4E+16

6E+16

8E+16

1E+17

-1.1 -0.9 -0.7 -0.5 -0.3 -0.1 0.1

ch
an

g
e 

in
 s

to
ra

g
e

concavity index

y = -3E+16x + 2E+16

R² = 1

y = -3E+18x6 + 9E+18x5 - 8E+18x4 + 3E+18x3 - 5E+17x2 + 8E+16x - 2E+16

R² = 0.9989

y = 3E+18x6 - 9E+18x5 + 8E+18x4 - 3E+18x3 + 5E+17x2 - 1E+17x + 6E+16

R² = 0.9984

-8E+16

-6E+16

-4E+16

-2E+16

0

2E+16

4E+16

6E+16

8E+16

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

ch
an

g
e 

in
 s

to
ra

g
e

hypsometric integral



83 
 

Appendix K: Differences between actual and predicted hydrologic values for currently 

gaged streams on Maui 
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